Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of SEIKO EPSON CORPORATION. The information contained herein is designed only for use with this EPSON printer. EPSON is not responsible for any use of this information as applied to other printers.

Neither SEIKO EPSON CORPORATION nor its affiliates shall be liable to the purchaser of this product or third parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to strictly comply with SEIKO EPSON CORPORATION’s operating and maintenance instructions.

SEIKO EPSON CORPORATION shall not be liable for any damages or problems arising from the use of any options or any consumable products other than those designated as Original EPSON Products or EPSON Approved Products by SEIKO EPSON CORPORATION.

A Note Concerning the Responsible Use of Copyrighted Materials

Digital cameras and scanners, like photocopiers, conventional cameras, and ink jet printers, can be misused by improper copying and reprinting of copyrighted material. While some countries’ laws permit limited copying of copyrighted material in certain circumstances, those circumstances may not be as broad as some people assume. EPSON encourages each user to be responsible and respectful of the copyright laws when using digital cameras, scanners, and ink jet printers.

Trademarks

EPSON, EPSON Stylus, EPSON Photo Stickers, and MicroWeave are registered trademarks and PRINT Image Matching and the PRINT Image Matching logo are trademarks of SEIKO EPSON CORPORATION.

RPM is a registered trademark, EPSON Print Lab, EPSON PhotoCenter, EPSON Store, SoundAdvice, and EPSON Connection are service marks, and Resolution Performance Management, EPSON Software, ColorLife, PhotoEnhance, and BorderFree are trademarks of Epson America, Inc.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of their respective owners. EPSON disclaims any and all rights in those marks.

The ENERGY STAR emblem does not represent EPA endorsement of any product or service.
# Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Welcome!</td>
<td>7</td>
</tr>
<tr>
<td>About PRINT Image Matching</td>
<td>8</td>
</tr>
<tr>
<td>About Exif Print</td>
<td>8</td>
</tr>
<tr>
<td>About Your Software</td>
<td>9</td>
</tr>
<tr>
<td>About Your Documentation</td>
<td>10</td>
</tr>
<tr>
<td>Warnings, Cautions, Notes, and Tips</td>
<td>10</td>
</tr>
<tr>
<td>Viewing Your On-Screen Reference Guide</td>
<td>10</td>
</tr>
<tr>
<td><strong>Using EPSON Paper</strong></td>
<td>13</td>
</tr>
<tr>
<td>Choosing the Paper for Your Project</td>
<td>13</td>
</tr>
<tr>
<td>Loading Paper in the Sheet Feeder</td>
<td>14</td>
</tr>
<tr>
<td>Loading Envelopes</td>
<td>15</td>
</tr>
<tr>
<td>Storing Your Photos</td>
<td>16</td>
</tr>
<tr>
<td><strong>Printing Without a Computer</strong></td>
<td>17</td>
</tr>
<tr>
<td>Using Your Camera’s Print Settings</td>
<td>18</td>
</tr>
<tr>
<td>Using PRINT Image Matching</td>
<td>18</td>
</tr>
<tr>
<td>Using DPOF or PictBridge</td>
<td>18</td>
</tr>
<tr>
<td>Getting Photos into the Printer</td>
<td>19</td>
</tr>
<tr>
<td>Inserting a Memory Card</td>
<td>19</td>
</tr>
<tr>
<td>Removing a Memory Card</td>
<td>20</td>
</tr>
<tr>
<td>Connecting a Digital Camera or Storage Device</td>
<td>20</td>
</tr>
<tr>
<td>Choosing Basic Mode or Advanced Mode</td>
<td>22</td>
</tr>
<tr>
<td>Selecting Photos for Printing</td>
<td>22</td>
</tr>
<tr>
<td>Printing an Index</td>
<td>23</td>
</tr>
<tr>
<td>Selecting One Photo</td>
<td>24</td>
</tr>
<tr>
<td>Selecting a Set of Photos</td>
<td>24</td>
</tr>
<tr>
<td>Selecting a Range of Photos</td>
<td>25</td>
</tr>
<tr>
<td>Using DPOF or PictBridge to Select Your Photos</td>
<td>25</td>
</tr>
</tbody>
</table>
Printing Your Selected Photos
  Selecting the Correct Paper Type 27
  One-Touch Printing 28
Touching Up Your Photos
  Automatically Adjusting Your Photos 29
  Manually Adjusting Your Photos 30
Cropping and Sizing Your Photos 31
Adding Photo Information 32
Printing Special Layouts 33
  Printing Greeting Cards 34
  Printing With Iron-On Transfer Paper 35
  Printing On CDs or DVDs 36
  Printing Jewel Case Inserts 39
Saving Your Image Files to a CD or Zip Disk 39
Using a Bluetooth Device With Your Printer 41
  Connecting the Bluetooth Photo Print Adapter 41
  Disconnecting the Bluetooth Photo Print Adapter 42
  Printing With Bluetooth 43
  Choosing Bluetooth Settings 44
Resetting Default Settings 46

**Printing From Your Computer** 47
Copying Photos to Your Computer 48
  Configuring PhotoStarter 49
  Removing a Memory Card 50
Basic Printing in Windows 50
  Selecting Default Settings 52
Basic Printing on a Macintosh 53
  Printing in OS X 53
  Printing with OS 8.6 to 9.x 56
Customizing Your Print Settings 58
  Customizing Windows Print Settings 58
  Customizing Macintosh Print Settings 60
Selecting the Correct Paper (Media) Type 61
Uninstalling Printer Software
  Windows
  Macintosh OS X
  Macintosh OS 8.6 to 9x
Where To Get Help

Notices
  Windows System Requirements
  Macintosh System Requirements
  Important Safety Instructions
    Ink Cartridge Safety Instructions
  Energy Star Compliance
  FCC Compliance Statement
  Declaration of Conformity
  Epson America, Inc., Limited Warranty

Index
Welcome!

Your EPSON Stylus® Photo R300 Series printer can print pictures directly from your digital camera’s memory card. You can create true BorderFree™ photos directly from your printer in a variety of sizes perfect for albums or framing. You get quick and easy snapshots just minutes after taking pictures with your digital camera.

If you want to save your picture files, you can transfer them immediately to your Windows® or Macintosh® computer and print from your PC.

Here are some of the printer’s outstanding features:

- EPSON’s exclusive 6-color ink technology lets you achieve fine shadow detail, dazzling highlights, and excellent fill across a wide range of colors. Genuine EPSON® ink and papers create long-lasting and water-resistant prints.
- CD and DVD printing on ink jet-printable CDs and DVDs, with or without a computer.
- Ground-breaking Resolution Performance Management™ (RPM®) technology optimizes the number and placement of ink droplets on a variety of papers for superior photo quality and performance, with manageable print file sizes.
- Three built-in memory card slots support CompactFlash™ Type I and II, Secure Digital, MultiMediaCard, xD Picture Card, SmartMedia™, Sony Memory Stick®, Memory Stick Pro, Memory Stick DUO, and IBM® Microdrive™.
- An extra USB port on the front lets you connect a digital camera (supported models only) or an external storage device, such as an Iomega® Zip® drive or CD-R drive, directly to the printer. This lets you save your memory card contents to a CD-R or Zip disk and access stored photos without a computer. (The port in the back of the printer is for connecting the printer to your computer.)
- If you have the EPSON Stylus Photo R300M, your printer has a preview monitor to help you select photos for printing.
- Your printer also supports Bluetooth® technology (using an optional adapter) for sending prints wirelessly from your Bluetooth-enabled phones, PDAs, etc.
About PRINT Image Matching

Your EPSON Stylus Photo R300 Series printer includes support for EPSON’s revolutionary PRINT Image Matching™ technology. PRINT Image Matching lets your digital camera and printer work together automatically to produce the best prints possible. Digital camera manufacturers that support PRINT Image Matching include EPSON, Casio®, JVC®, Konica®, Kyocera®, Leica®, Minolta®, Nikon®, Olympus®, Panasonic®, Pentax®, Ricoh®, Sanyo®, and Toshiba®. Check with your camera’s manufacturer or visit www.printimagematching.com to find out if PRINT Image Matching technology is included with your camera.

With PRINT Image Matching, the digital camera manufacturer can set specific printing options for each camera model. These options include:

- Contrast, sharpness, and brightness
- Gamma level, color space, color saturation, and noise reduction
- Shadow point, highlight point, and color balance

The camera saves this information in each JPEG image file (and TIFF files from P.I.M. II-enabled cameras). Your printer—along with P.I.M.-enabled software, such as EPSON Software™ Film Factory™ or the P.I.M. II Plug-in for Adobe® Photoshop®—uses the information to ensure the most accurate image reproduction.

But don’t worry if your camera doesn’t include PRINT Image Matching technology—your EPSON Stylus Photo R300 series printer gives great photo printing results.

About Exif Print

The Exif (Exchangeable Image File) Print format includes information about your digital camera settings in JPEG files so your printer and application can use them to create accurate print settings. Most digital cameras store Exif Print information such as shutter speed, metering, flash, exposure settings, resolution, and lens use in the JPEG image file. Your printer—along with EPSON Software Film Factory or P.I.M. II Plug-in—uses the information to ensure the most accurate image reproduction.
About Your Software

The printer software CD-ROM that came with your printer includes all the software you need for printing. See the Start Here sheet for installation instructions.

- **Your printer driver** runs your printer and lets you control how your documents look. You can’t print from your computer without it.

  **Tip:** It’s a good idea to check EPSON’s support web site periodically for free updates to your printer driver. Visit http://support.epson.com. Download instructions are posted for your convenience.

- **Your photo software** includes these great tools:

  EPSON Software Film Factory is a photo management program that lets you organize, beautify, and print your photos in a flash. Supports PRINT Image Matching (both P.I.M. and P.I.M. II) and Exif Print.

  EPSON PhotoStarter and CardMonitor utilities help your system handle photos on a memory card. If you want, you can have your photos copied to your computer automatically—and even open one of your photo editing programs—whenever you insert a memory card in your printer. (These programs are installed automatically with your printer driver.)

  P.I.M. II Plug-in for Adobe Photoshop lets you retain PRINT Image Matching and Exif Print image quality when you import JPEG or TIFF files from your P.I.M. -, P.I.M. II-, or Exif Print-enabled digital camera. (Compatible with Photoshop 6.0 and 7.0, and Photoshop Elements 1.0 and 2.0.)

- **Your on-screen Reference Guide** gives you additional details about your printer. You need a browser—such as Microsoft® Internet Explorer version 4.0 or later, Netscape® Navigator® version 3.0 or later, or Safari™ version 1.0 or later—to view the guide. See page 10 for details.

- **EPSON PhotoCenter** is EPSON’s free photo-sharing web site where you can store, organize, and share your photos; print high-resolution photos straight from the web; and create free online postcards with your photos. Your printer software installer lets you add a link to the EPSON PhotoCenter on your desktop.
About Your Documentation

To set up your printer and install its software, see the Start Here sheet. For basic printing without a computer, see the Quick Reference card. This book contains system requirements, important safety information, your warranty, and instructions on:

- Viewing your on-screen Reference Guide
- Printing all types of photos without a computer
- Printing with Windows or on a Macintosh
- Printing on CDs, DVDs, and creating jewel case inserts
- Maintaining the printer
- Solving basic problems

For more details about printing with, maintaining, or troubleshooting your printer, see your on-screen Reference Guide, as described below.

Warnings, Cautions, Notes, and Tips

Please follow these guidelines:

- **Warnings** must be followed carefully to avoid bodily injury.
- **Cautions** must be observed to avoid damage to your equipment.
- **Notes** contain important information about your printer.
- **Tips** contain additional hints for better printing.

Viewing Your On-Screen Reference Guide

Your printer CD-ROM includes an on-screen Reference Guide. You need a browser—such as Microsoft Internet Explorer 4.0 or later, Netscape Navigator 3.0 or later, or Safari 1.0 or later—to view it. If you are using a different browser, the pages may not display correctly.

(A browser is not included on the printer software CD-ROM.)

You can view the Reference Guide by doing one of the following:

- **Windows**: Double-click the SPR300 Reference Guide icon on your desktop. You can also click Start, Programs (or All Programs in Windows XP), EPSON, SPR300 Reference Guide, then click Reference Guide.
- **Macintosh**: Double-click the SPR300 Reference Guide icon on your desktop.
When you first open the Reference Guide, you see this screen:

Click a topic on the left to expand the table of contents, then click on the topic you want to view.

- If there's a right arrow, click it to view subtopics, then click a topic.
- Click the down arrow to close a subtopic list.

If you see an icon for a graphic when viewing your Reference Guide in Netscape Navigator, click the Reload button to load the graphic.
Using EPSON Paper

EPSON offers a wide variety of papers that let you customize your projects and achieve professional results. This chapter gives you guidelines on:

- “Choosing the Paper for Your Project” below
- “Loading Paper in the Sheet Feeder” on page 14
- “Loading Envelopes” on page 15
- “Storing Your Photos” on page 16

**Note:** For instructions on loading printable CDs and DVDs, see page 36 (stand-alone printing) or page 70 (printing from a computer).

### Choosing the Paper for Your Project

Once you know which photos you want to print, you need to select the type of paper to print them on, the paper size, and your layout. Here are some helpful tips:

- Select a type of paper to suit your image. For best quality, use one of the special EPSON papers listed on the inside back cover.
- Use the EPSON paper and ink designed for your printer. If you use incompatible paper, you may not get the results you expect.
- Select a paper size and layout to get the photos you want. When the printer is used in Advanced stand-alone mode (without connecting it to a computer), it automatically resizes your photos to fit the layout you choose—from letter-size to 4 × 6-inch paper. (In Basic stand-alone mode, you can print on 4 × 6 Premium Glossy Photo Paper only.)

**Note:** You must print borderless on supported types and sizes of paper: see page 62 for a list. Stand-alone mode supports the paper types listed on page 27.

To order EPSON paper, contact your dealer, call the EPSON Store℠ at (800) 873-7766, or visit our web site at www.epsonstore.com (U.S. sales only). In Canada, please call (800) 463-7766 for dealer referral.
Loading Paper in the Sheet Feeder

1. Make sure the paper support is open and the extension is raised up.

2. Place your paper against the right edge of the feeder. Make sure the printable (whiter or glossier) side of the paper is face up. If you are loading multiple sheets, fan the stack of paper before loading it to prevent paper jams.

   Note: Don’t load paper above the arrow mark inside the left edge guide. Some special papers can be loaded only one sheet at a time. See your online Reference Guide for details.

3. Slide the left edge guide against the paper. (For letter-size paper, you may not need to move the edge guide over.)

4. Open the output tray and pull out the extension.

You should also follow these guidelines:

- Always load the short edge first, even when you're printing landscape-oriented pictures.
- When using special papers, check the paper package for additional instructions. Some papers require using a support sheet included in the package.

   Note: Always keep unused paper in the original package and store it flat to prevent curling.
Loading Envelopes

You can load up to 10 envelopes at a time:

1. Place the envelopes against the right edge of the sheet feeder. Load them with the printable side facing you, flap-edge to the left. Then slide the left edge guide against the envelopes.

   **Tip:** For best results, press each envelope flat before loading it, or load one envelope at a time.

2. Select these settings in your printer software:
   - For the paper Type/Media Type, select Plain Paper
   - For the Size/Paper Size, select the size of your envelopes
   - For the Orientation, select Landscape (in Macintosh OS X, click the icon)

See page 50 (Windows), page 53 (Macintosh OS X), or page 56 (Macintosh OS 8.6 to 9.x) for more information.
Storing Your Photos

With proper care, photographs from your EPSON Stylus Photo R300 Series printer will last for many years. The special EPSON inks designed for your printer are formulated to achieve improved lightfastness when used with EPSON papers for prints that are properly displayed or stored.

As with traditional photos, proper care will minimize color changes and lengthen display life:

- For display, EPSON recommends that prints be framed under glass or a protective plastic sleeve to protect them from atmospheric contaminants like humidity, cigarette smoke, and high levels of ozone.

- As with all photographs, keep your prints away from high temperatures and humidity and out of direct sunlight.

- For proper storage, EPSON recommends that you keep prints in a photo album or plastic photo storage box in acid-free, archival sleeves commonly available from most camera stores.

- Be sure to follow any other storage and display instructions included in the paper package.
Printing Without a Computer

Your EPSON Stylus Photo R300 Series printer lets you print photos quickly and easily without a computer. Just insert your digital camera’s memory card, choose settings from the control panel, and press the green printer button.

Before you start, make sure you plug in the printer, turn it on, install ink cartridges, and load paper, as described on your Start Here sheet. Then follow the instructions in these sections:

- “Using Your Camera’s Print Settings” on page 18
- “Getting Photos into the Printer” on page 19
- “Choosing Basic Mode or Advanced Mode” on page 22
- “Selecting Photos for Printing” on page 22
- “Printing Your Selected Photos” on page 26
- “Touching Up Your Photos” on page 29
- “Cropping and Sizing Your Photos” on page 31
- “Adding Photo Information” on page 32
- “Printing Special Layouts” on page 33
- “Saving Your Image Files to a CD or Zip Disk” on page 39
- “Using a Bluetooth Device With Your Printer” on page 41
- “Resetting Default Settings” on page 46
Using Your Camera’s Print Settings

Your EPSON Stylus Photo R300 Series printer is designed to work hand-in-hand with the latest advances in digital cameras. With PRINT Image Matching, you can get beautiful print results from all your digital photos, easily and automatically. And with PictBridge or DPOF (Digital Print Order Format), you can use your camera to select which photos you want to print—before you even get home to your printer.

Using PRINT Image Matching

If your digital camera supports PRINT Image Matching (P.I.M. or P.I.M. II), you can use this technology whenever you print.

With PRINT Image Matching, special print instructions are automatically saved in your photo files. For example, macro mode pictures might include commands for sharpness and clarity, while portrait mode pictures might emphasize soft focusing and subtle flesh tones.

When you connect your camera to the printer or insert its memory card, all the PRINT Image Matching commands are read and applied; this ensures the most faithful possible reproduction of the images taken by your camera. A special icon is displayed on the control panel to remind you that your photos contain PRINT Image Matching data.

If you don’t want to use PRINT Image Matching, you can turn it off as described on page 29. You can also use PRINT Image Matching when printing from your computer; see page 78.

Using DPOF or PictBridge

DPOF and PictBridge are features of many digital cameras that let you select images and determine how many copies of each image you want to print right from the control panel. PictBridge also saves special print instructions, and allows you to print when connecting your camera directly to the printer. When you connect your camera to the printer or insert its memory card, DPOF or PictBridge displays as the Select Photo option; your photos and the number of copies you want to print are automatically selected; all you have to do is choose your paper type and size, then print. For details on using DPOF and PictBridge, see page 25.
Getting Photos into the Printer

Your EPSON Stylus Photo R300 Series printer can print photos stored:

- On a memory card (see below)
- In a digital camera (see page 20)
- On a data storage device, such as a CD-R drive or an Iomega Zip drive (see page 20)
- On a Bluetooth-enabled device with the optional Bluetooth Photo Print adapter (see page 41)

The file storage device should comply with DCF (Design rule for Camera File systems) Version 1.0.

However your photos are stored, make sure the image files meet these requirements:

- JPEG files or uncompressed Tiff files only
- Resolutions ranging from 160 × 160 to 4600 × 4600 pixels
- No more than 999 images (although you may have additional images on your card or storage device, the printer can read only the first 999)

Inserting a Memory Card

Your printer works with many types of memory cards. Follow these guidelines to insert your memory card:

1. Make sure the printer is turned on, then insert the memory card into the appropriate slot, as shown:

   CompactFlash or Microdrive (left)
   Memory Stick, SD (Secure Digital), or MMC (MultiMediaCard) (middle)
   SmartMedia or xD Picture Card (right)

2. Close the memory card cover.
After a moment, the printer reads and counts the number of images on your card. When it’s done, your images are available for printing.

**Note:** Insert just one card at a time. The printer can’t read multiple cards at once.

### Removing a Memory Card

When you’re finished printing from a memory card, make sure the light below the card slot is not flashing before you remove it.

**Caution:** Do not eject a card while the processing light is flashing, or you may lose data on the card.

To remove a card, pull the card straight out of the slot.

### Connecting a Digital Camera or Storage Device

If you have one of the following devices, you can connect it directly to your printer using a USB cable:

- Digital camera with PictBridge or USB DP support
- USB CD/DVD burners and drives (selected drives: see http://support.epson.com for a list of compatible drives) USB 2.0 (high-speed) drives are recommended
- 100 or 250MB Iomega Zip drive, AC or USB powered
- Memory cards with a commercially available USB adapter (such as the MicroTech ZiO™).
- MO (Magneto-Optical) drives

**Note:** If you’re not sure about your camera or drive, you can try connecting it. If it’s not compatible, you’ll see a screen saying that the connected device cannot be used. EPSON cannot guarantee the compatibility of any cameras or drives.

If you are using a Zip disk, it must be formatted as a FAT16 disk. Also, if you insert a Macintosh disk into a Zip drive attached to the printer, it automatically formats it, so be sure to use a disk that is empty or not formatted, or one containing data you don’t mind losing. (You will be prompted before any data is erased.)

**Tip:** When you connect a CD-drive, you can also print photos from Picture CDs that you get from your photo lab.
When you connect a digital camera or storage device, the printer treats it like a memory card. Follow these steps to connect it:

1. Remove any memory cards from the printer.
   
   (If you leave a card in the printer, images will be read from the card instead of your camera or external storage device.)

2. Connect the USB cable from your camera or data storage device to the EXT I/F USB port on the front of the printer. Some digital cameras require a special USB cable; if so, be sure to use the one that came with the camera.

3. Turn on the printer and your camera or data storage device. After a moment, the printer reads and counts the number of images on your device. When it’s done, you see a screen similar to this on the printer’s control panel and your images are available for printing:

   ![Printer Control Panel](image)

   **Note:** If you’ve backed up your images on Zip disk, CD, or another storage device (see page 39), they’re stored in folders (001, 002, etc.). Use the \( \circ \) and \( \circ \) buttons on the printer’s control panel to highlight the folder you want to open, then press OK to open it.
Choosing Basic Mode or Advanced Mode

You can select Basic mode to create quick and easy 4 × 6-inch photo prints using EPSON Premium Glossy Photo Paper. Advanced mode lets you print with any paper type and size that is available, and lets you change quality settings and make other adjustments to your photos. You can also use Advanced mode to perform maintenance functions from your printer’s control panel. All the features described in this book require the printer to be set to the Advanced mode. To use Basic mode, see the Quick Reference guide.

Selecting Photos for Printing

Before selecting the photos you want to print, make sure you have inserted your memory card or connected your camera or CD drive to the printer. See page 19.

- If you have the EPSON Stylus Photo R300 printer, start by printing an index, so you can select your photos by number. See page 23 for details.

- If you have the EPSON Stylus Photo R300M printer, you can use the preview monitor to easily select your photos.

Once you know which photos are available for printing, you can select a single photo (page 24), a set of photos (page 24), a range of photos (page 25) or all the photos (page 24).

- If you’ve used your camera’s PictBridge or DPOF (Digital Print Order Format) feature to select the photos you want to print, you won’t have to print an index. When you insert the camera’s memory card or connect your camera with PictBridge, PictBridge or DPOF displays as the Print Mode and your photos are automatically selected. (If you don’t want to use PictBridge or DPOF, you can choose a different Print Mode.) See page 25 for details.
Printing an Index

An index print shows small, numbered images of all the photos on your memory card—and includes the date each picture was taken. This enables you to select the photos you want to print. If you have the EPSON Stylus Photo R300M printer with the preview monitor, you may not need to print an index.

1. Load your paper in the printer. See page 14.
2. Highlight Select Photo, then press OK.
3. In the Select Photo menu, use the \( \text{\( \Rightarrow \)} \) and \( \text{\( \Leftarrow \)} \) buttons to highlight Index, then press OK to select it.

4. Press the \( \text{\( \Rightarrow \)} \) and \( \text{\( \Leftarrow \)} \) buttons to highlight Paper Type, then press OK to enter the Paper Type menu.
5. Highlight the type of paper you’ve loaded, then press OK. (If you’re not sure about the paper type, see the table on page 27.

   Note: It’s important to select the correct Paper Type setting for the paper you’re using, or the print quality may not be what you expect.

6. Enter the Paper Size menu, then select the size of paper you’ve loaded.
7. Press the \( \text{\( \Rightarrow \)} \) Print button. Your index starts printing.

   Note: If you would prefer to print an index print with larger images, choose All under the Select Photo menu, then choose a different layout setting. See page 26.
Selecting One Photo

You can select a photo, then print one or more copies of it on a page using a variety of layouts. If your printer doesn't have the preview monitor, first print an index to identify the photos on the memory card (see page 23).

1. Highlight Select Photo, then press OK.
2. In the Select Photo menu, use the \( \) and \( \) buttons to highlight the number of the photo you want to print, then press OK to select it.
3. If you want to print more than one copy of this photo, highlight Copies and press OK, then use the \( \) and \( \) buttons to select the desired number of copies and press OK.
4. Continue with “Printing Your Selected Photos” on page 26 to finish laying out your photos and setting up your print job.

Selecting a Set of Photos

You can select two or more photos, then print them as a group using a variety of layouts. If you've selected more photos than can fit on a page, the printer automatically prints additional pages as needed, using the same layout. If your printer doesn't have the preview monitor, first print an index to identify the photos on the memory card (see page 23).

1. Highlight Select Photo, then press OK.

   Note: To print all your photos, select All. To print a range of photos, see page 25.
2. Use the \( \) button to highlight Individual, then press OK. (If you have the preview monitor, it displays the first photo on your card.)
3. Use the \( \) and \( \) buttons to select the photo you want to print, then press OK.
4. If you want to print more than one copy of this photo, use the \( \) and \( \) buttons to select the desired number of copies, then press OK.
5. Repeat steps 3 and 4 for each additional photo you want to print.
6. When you're done, press Back.
7. To view a list of selected photos, highlight Copies and press OK. Then press Back.

   Note: If you selected the wrong photo, you can remove it from the list of selected photos. Simply change its number of copies to zero; see step 4.
8. Continue with “Printing Your Selected Photos” on page 26 to finish laying out your photos and setting up your print job.
Selecting a Range of Photos

You can select a range of photos to print if you took a set of photos that you want to print out at once.

If your printer doesn't have the preview monitor, first print an index to identify the photos on the memory card (as described on page 23).

1. Highlight Select Photo, then press OK.
2. Highlight Range, then press OK.
3. Choose a starting photo under the From: option using the and buttons. (Hold down either button to scroll quickly through the photo numbers.)
4. Press OK.

5. Choose an ending photo under the To: option using the and buttons.
6. Press OK. The range appears on the right side of the LCD.
7. If you want to print more than one copy of this range, highlight Copies and press OK, then use the and buttons to select the desired number of copies and press OK.
8. Continue with “Printing Your Selected Photos” on page 26 to finish laying out your photos and setting up your print job.

Using DPOF or PictBridge to Select Your Photos

If your camera supports DPOF or PictBridge, you can use it to select photos for printing; see your camera's instruction manual for details. When you connect your camera or insert its memory card, DPOF or PictBridge automatically displays under the Select Photo menu. Your photos and the number of copies you want to print are already selected.

To print, continue with “Printing Your Selected Photos” on page 26 to finish laying out your photos and setting up your print job.

If you don't want to use DPOF or PictBridge, you can turn it off by selecting photos from the Select Photo menu, as described on pages 24 through 25.
Printing Your Selected Photos

Once you’ve selected your photos, follow these steps to start printing:

1. Load your paper in the printer. See page 14.

2. Press the 
   and 
   buttons to highlight Paper Type, then press OK to enter the Paper
   Type menu.

3. Highlight the type of paper you’ve loaded, then press OK. (If you’re not sure about the
   paper type, see the table on page 27.)
   
   **Note:** It’s important to select the correct Paper Type setting for the paper you’re
   using, or the print quality may not be what you expect.

4. Enter the Paper Size menu, then select the size of paper you’ve loaded.

5. In the Layout menu, select one of the following:

   - Prints one photo per sheet, borderless; fits the photo lengthwise on the paper.
   - Prints one photo per sheet, with borders around the edges.
   - Prints a photo on the top half of the sheet.
   - Prints two photos per sheet.
   - Prints four photos per sheet.
   - Prints eight photos per sheet.
   - Prints 20 photos per sheet; the photo number and date are also printed with each
     photo. (Good for printing larger-size index prints.)
   - Prints an index of your photos. 80 photos are printed on letter-size paper.
   - Prints a jewel case insert with one photo on one side of the insert.
   - Prints a jewel case insert with twenty-four photos; twelve on each side of the insert.
   
   **Note:** If you don’t see the entire image in your prints, check to make sure the Fit
   to Frame and Crop options are Off. See page 31.

6. If you’ve selected a single photo, all photos, an index, or a range of photos, you can print
   multiple sheets of your selected layout. Enter the Copies menu, then select from 1 to 100
   copies.
If you've selected a set of photos with the Individual option, or if you're using DPOF or PictBridge, the number of copies is automatically determined (it's displayed as **Pages** next to the **Copies** setting); you cannot change this setting.

7. If you like, you can make further changes before printing. See “Touching Up Your Photos” on page 29, “Cropping and Sizing Your Photos” on page 31, and “Adding Photo Information” on page 32.

8. Press the **Print** button. Your print job begins printing.

**Note:** To cancel a print job while printing, press the **Stop** button.

Keep your pictures and unused paper away from high temperatures and humidity and out of direct sunlight. See page 16 for more information about storing and displaying your pictures.

**Selecting the Correct Paper Type**

When printing, be sure to select the correct Paper Type setting. This tells the printer what kind of paper you're using so it can adjust the ink coverage accordingly.

Here are the settings you should choose from your printer’s control panel when not using your computer to print:

<table>
<thead>
<tr>
<th>For this paper . . .</th>
<th>Select this Paper Type setting . . .</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper</td>
<td>Plain</td>
</tr>
<tr>
<td>EPSON Photo Paper</td>
<td>GlossyPhoto</td>
</tr>
<tr>
<td>EPSON Glossy Photo Paper</td>
<td></td>
</tr>
<tr>
<td>EPSON Premium Glossy Photo Paper</td>
<td>Prem.Glossy</td>
</tr>
<tr>
<td>EPSON Premium Semigloss Photo Paper</td>
<td>Semigloss</td>
</tr>
<tr>
<td>EPSON Premium Luster Photo Paper</td>
<td>Prem.Luster</td>
</tr>
<tr>
<td>EPSON Matte Paper Heavyweight PremierArt™ Matte Scrapbook Photo Paper for Epson</td>
<td>Matte</td>
</tr>
<tr>
<td>EPSON ColorLife™ Photo Paper</td>
<td>ColorLife</td>
</tr>
<tr>
<td>EPSON Iron-On Transfer Paper</td>
<td>Iron-on</td>
</tr>
<tr>
<td>EPSON Glossy Photo Greeting Cards</td>
<td>Greeting</td>
</tr>
</tbody>
</table>
**One-Touch Printing**

If there are settings you may use often, you can create your own custom settings and recall them at any time by pressing the **Custom** button.

1. From the control panel, select any of the following settings you want to use:

   - Automatic Correction
   - Filter
   - Saturation
   - Contrast
   - Paper Type
   - Brightness
   - Quality
   - Paper Size
   - Layout
   - Sharpness

   **Tip:** It's a good idea to make a note of the settings you've programmed into the Custom button.

2. Press and hold the **Custom** button for at least three seconds, until you see a message saying that your settings have been saved.

When you want to print, press the **Custom** button to recall your settings. Make sure the correct paper is loaded, then press ⬇ Print.

   **Tip:** If you adjust any settings after pressing the **Custom** button, any additional changes you make affect only the current print job and are not saved with your custom settings.
Touching Up Your Photos

Your EPSON Stylus Photo R300 Series printer lets you correct the color and improve the image quality of your photos even without a computer. Two basic types of adjustments are available.

**Note:** These settings affect only your printed pictures. They do not change your original image files.

These settings are saved when you turn off the printer or choose a different set of photos, so remember to turn off the settings when you’re done.

- **Automatic adjustments** (see below)
  - If your camera supports PRINT Image Matching or Exif Print, you can use the printer’s P.I.M. or Exif Print setting to automatically adjust your photos for the best results.
  - If your camera doesn’t support PRINT Image Matching or Exif Print, you can use PhotoEnhance™ to make adjustments for the type of environment in which your photos were taken.

- **Manual adjustments** (see page 30)
  - If your photos are too light or too dark, you can adjust their brightness, or control the saturation and sharpness.
  - If you want, you can make manual adjustments while P.I.M., Exif Print, or PhotoEnhance are turned on in order to fine-tune your automatic settings.

**Automatically Adjusting Your Photos**

When you use the printer’s automatic image adjustments, the adjustments are applied to all your photos.

1. Press the button until More Options is highlighted, then press OK.
2. Use the and buttons to highlight Automatic Correction, then press OK.
3. Choose from these options and then press OK:
   - P.I.M. uses your camera’s PRINT Image Matching settings (this option is automatically selected when your pictures contain P.I.M. data).
   - Exif uses your camera’s Exif Print settings (this option is automatically selected when your pictures contain Exif Print data).
■ **PhotoEnhance** adjusts the brightness, contrast, and saturation of your photos.

■ **None** if you don’t want to use P.I.M., Exif, or PhotoEnhance.

4. To boost the appearance of small images taken from mobile phones and low-resolution PDAs, press the button to choose **Small Image Enhancer**, then highlight **On** and press **OK**. (Make sure to turn this option off when printing most photos, or your printer will print slowly.)

**Note:** These settings are saved when you turn off the printer or choose a different set of photos, so remember to turn off the settings when you’re done.

To make manual adjustments in addition to the automatic ones, follow the steps in the next section.

**Manually Adjusting Your Photos**

1. Press the button to highlight **More Options**, then press **OK**.

2. Highlight **Contrast**, **Brightness**, **Saturation**, **Sharpness**, or **Filter**, then press **OK**.

3. Choose your setting, then press **OK**.

![](chart.png)

**Note:** These settings are saved when you turn off the printer or choose a different set of photos, so remember to turn off the settings when you’re done.
Cropping and Sizing Your Photos

Your EPSON Stylus Photo R300 Series printer lets you decide how your photos fit on the page with two options: **Crop** and **Fit to Frame**.

1. Press the button to highlight **More Options**, then press **OK**.
2. To print only a portion of your image, highlight **Crop** and press **OK**. You can choose from 18 preset cropping options.

The dimensions 1.2× and 1.5× indicate how much the printed part of your photo is zoomed. For example, if you select 1.5×, it zooms in to 1.5 times the original size. A higher zoom level results in more of the image being cropped out of the photo.

If you’re using the preview monitor, you see a yellow border around the cropped area (shown above in black). Use the border only as a rough guide, since it is not exact.

**Note:** The entire photo still appears on the preview monitor after choosing a crop setting and does not reflect what you will see in your print.
3. Choose an option and press OK. (Choose Off to turn off cropping.)

4. If your photo is too long or wide to fit inside the available space on your selected layout, part of the image will be automatically cropped. If you want to turn off automatic cropping (leaving white space at the edges of the photo), highlight Fit to Frame and press OK, then highlight Off and press OK.

Note: These settings are saved when you turn off the printer or choose a different set of photos, so remember to turn off the settings when you’re done.

Adding Photo Information

You can print the date and time each photo was taken, as well as the camera settings, in the lower right corner of your photos.

1. Highlight More Options, then press OK.

2. To print the date, highlight Date, then press OK. Highlight a month, date, and year formatting option, then press OK.

3. To print the time, highlight Time, then press OK. Highlight 12-hour system or 24-hour system, and press OK.

4. To print your camera’s exposure time (shutter speed), F-stop (aperture), and ISO speed, highlight Photo Information, then press OK. Highlight On, then press OK to activate the setting.

When Date, Time, or Photo Information is turned on, the information prints on all photos in any layouts for which they are allowed.

Note: These settings are saved when you turn off the printer or choose a different set of photos, so remember to change the settings back to None or Off when you’re done.
Printing Special Layouts

Using special EPSON paper, you can make greeting cards, CDs, jewel case inserts, and iron-on transfers without even turning on your computer.

You can buy the following EPSON papers for your projects:

- EPSON Glossy Photo Greeting Cards—S041606
- EPSON Iron-On Transfer Paper—S041153

To order EPSON paper, contact your dealer or call the EPSON Store at (800) 873-7766, or visit our web site at www.epsonstore.com (U.S. sales only). In Canada, please call (800) 463-7766 for dealer referral.

Printing Greeting Cards

With EPSON Glossy Photo Greeting Cards, you can create your own personalized cards by printing your photo right on the front of each card.

1. Select the photo you want to use, as described on page 22.

2. Follow the instructions in the paper package to load a sheet of greeting card paper with the support sheet behind it. Make sure the paper is loaded with the cut corner in the upper right.

3. Highlight Paper Type, then press OK.

4. Highlight Greeting, then press OK.

5. To print without borders around your image, make sure Fit to Frame is set to On (see page 32). If your image is not the same shape as the card, a portion of it will print beyond the perforation marks and get cut off.

6. Optionally, you can adjust the color or image quality before printing (see page 29), or crop or size your photos (see page 31).

7. Press the Print button. Your greeting card begins printing.
Printing With Iron-On Transfer Paper

With EPSON Iron-On Transfer Paper, you can transfer your photos to T-shirts, aprons, or just about any cotton or cotton-blend fabric. The printer automatically creates a mirror-image of your photo so that any text looks correct once it’s transferred.

1. Select the photo you want to use, as described on page 22.

2. Follow the instructions in the paper package to load a sheet of transfer paper. Make sure the paper is loaded with the cut corner in the upper right.

3. Highlight Paper Type, then press OK.

4. Highlight Iron-on, then press OK.

5. Optionally, you can adjust the color or image quality before printing (see page 29), or crop or size your photos (see page 31).

6. Press the Print button. Your transfer image begins printing.

Follow the instructions that came with the paper to transfer your image.
Printing On CDs or DVDs

Your printer includes a special tray that lets you print your photos directly on any ink jet-printable CD or DVD. You can print on regular 12-cm CDs and DVDs.

Caution: Use only ink jet-printable CDs or DVDs for printing. Thermal-printable and regular CDs and DVDs should not be used with this printer.

Cleaning the Roller

Before you print on CDs or DVDs, it's a good idea to clean the roller inside the printer. You can do this by feeding and ejecting several sheets of plain paper.

1. Make sure the printer is turned on and letter-size paper is loaded.
2. Press the button on your printer to choose More Options and press OK.
3. Press the button to highlight Paper Feed/Paper Eject and press OK.
4. Press OK to feed paper into the printer.
5. Make sure Paper Feed/Paper Eject is still highlighted, then press OK. Press OK again to eject the paper from the printer.
6. Repeat steps 4 and 5 several times.
**Printing**

Make sure the data, music, or video is burned on your ink-jet printable CDs or DVDs before you print. Otherwise, dirt or scratches on the surface may cause errors when you burn the data. If you plan to print large numbers of CDs or DVDs, it’s a good idea to print a small sample, then wait a day and check the quality to make sure it is satisfactory.

Before you insert a CD or DVD, make sure the printer is turned on. Otherwise, the disc may not be positioned correctly.

Then follow these steps to load CDs and DVDs into your printer:

**Caution:** If you don’t insert the tray correctly, you may damage the printer or tray.

1. Lift the printer lid and push in the output tray extension.

2. Lower the CD/DVD tray guide.

3. Your LCD panel displays a message, and then changes to show the CD/DVD Print Settings.
4. Place a standard-size CD or DVD on the CD tray with the white or printable side face-up. Make sure the disc lays flat in the tray.

**Caution:** Printing on small CDs (8 cm) is not supported when printing without a computer and may cause damage to the printer. See page 67 for instructions on printing on small CDs.

5. Insert the tray carefully, making sure it is level, not tilted up or down. Push the tray under the tab and the two rollers. Don’t push the tray in too far; line up the arrows exactly.

6. Highlight **Layout** and press **OK**. Choose from 1 photo across the whole disc, 4 photos, or 12 mini-photos.

7. Highlight **Select Photo** and press **OK**.

8. Select the photo or photos to print on your disc.

9. Press the **Print** button when you are ready to print. Your CD or DVD prints.

10. When printing is complete, slide the CD/DVD tray out from the printer and carefully remove the CD or DVD, holding it by the edges. Don’t touch the surface of the disc.

11. Set the CD or DVD aside and let it dry for 24 hours.

12. Close the CD/DVD tray guide when you are done printing, and close the printer cover.

**Note:** If your CDs are not aligned correctly, use the CD/DVD Print Position Up/Down or Left/Right options in the CD/DVD Print Settings menu on your control panel and choose how far your CD needs to shift. Use the CD position check paper to test the position.
Printing Jewel Case Inserts

You can create custom jewel case inserts with your photos. The printer adds cutting and folding lines that will let you fit the insert in any standard-sized plastic jewel case (not available for the small CD format).

Note: This feature is available when printing from the printer’s control panel only.

1. Select the photo you want to use, as described on page 22.
2. Load letter-size paper into your printer. (See “Loading Paper in the Sheet Feeder” on page 14 for details.)
3. Highlight Paper Type, then press OK.
4. Highlight the correct setting for the paper you have loaded (see page 27), then press OK.
5. Select the or layout, as described on page 33.
6. Press the Print button to print your jewel case insert.

Saving Your Image Files to a CD or Zip Disk

If you don’t have a computer, you can save the image files that are in your camera’s memory card on a Zip disk or CD-R. This lets you delete the images on your memory card and reuse it without losing your original images. Once your images are stored on a disk or CD, you can retrieve them at any time for printing.

To back up images, you need a 100 or 250MB Iomega Zip drive or CD-R/RW drive (with a USB connection), available at many computer stores. The drive must provide its own power. We recommend using USB 2.0-compatible CD-R/RW drives.

Note: If you insert a Macintosh-formatted disk into a Zip drive attached to the printer, it automatically formats it, so be sure to use a disk that is empty, or that contains data you don’t mind losing. You are prompted before any data is erased.

1. Make sure the printer is turned on and the memory card you want to back up is inserted in the printer.
2. If the printer is connected to your computer, unplug the USB cable that connects the printer to your computer.
3. Connect a USB cable from your drive to the EXT. I/F USB port on the front of the printer.

4. Press the Direct Save button.

5. Press OK. When you see the “Beginning Backup” message, press OK again to start the backup procedure; you may have to follow additional instructions on the printer screen. All the photos on your card are copied to your Zip disk or CD-R. Depending on how many photos there are, this may take several minutes.

   **Caution:** Once the backup starts, do not disconnect the cable or interrupt the process, or you may lose data. If you need to stop the backup, press the Stop button.

To print images saved on your Zip disk or CD-R, follow the instructions in “Connecting a Digital Camera or Storage Device” on page 20.
Using a Bluetooth Device With Your Printer

To send and print photos wirelessly from Bluetooth-enabled devices, such as digital still cameras, digital video cameras, PDAs, mobile phones, and computers, you can use the optional Bluetooth Photo Print adapter, available from EPSON.

The Bluetooth Photo Print adapter (C12C824142) is available from your local retailer or the EPSON Store at (800) 873-7766, or you can visit our web site at www.epsonstore.com (U.S. sales only). In Canada, please call (800) 463-7766 for dealer referral.

**Note:** While this product complies with the Bluetooth specification, it is not guaranteed to work with all devices enabled with Bluetooth wireless technology.

The communication range of this product is approximately 33 feet (10 meters); however, this may vary depending on conditions, including obstacles between devices, signal quality, magnetic fields, static electricity and electromagnetic interference, software, operating system, reception sensitivity, and antenna performance.

The following profiles are available: Basic Imaging Profile (BIP), Hardcopy Cable Replacement Profile (HCRP), and Object Push Profile (OPP).

**Connecting the Bluetooth Photo Print Adapter**

Fold down the top of the Bluetooth Photo Print adapter, then plug it into the EXT. I/F USB port on the front of the printer.

**Caution:** Do not connect the Bluetooth Photo Print adapter while the printer is printing. Doing so may cause the printer to malfunction.

The Bluetooth Photo Print adapter light comes on for one second. If the light does not turn on, disconnect the adapter from the printer, then reconnect it.
**Disconnecting the Bluetooth Photo Print Adapter**

Hold the Bluetooth adapter by the section that is connected to the printer, and pull it out from the USB connector, as shown below.

**Caution:** Do not remove the adapter while it is communicating with another device or while the printer is printing (while the blue light is flashing). Doing so may cause the printer to malfunction. Do not remove the adapter by pulling on the upper section. Doing so may damage the product.
**Printing With Bluetooth**

When you print using Bluetooth, you need to make print settings using the printer's LCD panel, then send an image to the printer from your device. Below is a basic description of how to print using the Bluetooth Photo Print adapter and this printer. See the documentation that came with your Bluetooth Photo Print adapter and your Bluetooth-enabled product for detailed printing instructions.

1. Use the printer's LCD panel to choose the number of copies you want to print. (To print more than 2 copies, you need to first select All as the Select Photo setting.)

2. If you are printing from Advanced mode, choose the Paper Type, Paper Size, and Layout settings. (See page 26 for details.)

3. Select the photo you want to print from your Bluetooth device and send it to the printer. (Make sure you are within about 30 feet of the printer.) Printing will start automatically using the settings you chose.

   **Note:** Available settings may vary among Bluetooth-enabled devices. For more information, refer to your device’s documentation.

If you are using Windows, you must use the software included with your computer’s Bluetooth adapter to set up a connection with your printer. Your adapter may let you print using your EPSON printer software. See the documentation included with your computer’s Bluetooth adapter.

If you are using Macintosh OS X 10.2 or later, you can use the Bluetooth Setup Assistant to set up a connection with the printer and the Bluetooth File Exchange utility to send a photo (see page 19 for file format requirements) to the printer. See your Mac Help for instructions.
Choosing Bluetooth Settings

If necessary, use your printer's LCD panel to choose settings for Bluetooth wireless communication. You may need to enter a passkey for your printer, or turn on encryption, depending on the settings for the Bluetooth-enabled device from which you want to print.

1. Press the button on your printer to choose More Options and press OK.

2. Choose settings in the Bluetooth option menus listed below.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BT Device Name Setting</td>
<td>EPSON Stylus Photo R300- (number) (Default = 0)</td>
<td>If multiple Bluetooth-enabled printers are in the same communication range, you can distinguish them by assigning each a unique number (from 0 through 9). To make the Device Name Setting take effect, turn the printer off and then back on.</td>
</tr>
<tr>
<td>BT Communication Mode</td>
<td>Public</td>
<td>This mode allows Bluetooth-enabled devices to freely discover the printer and send print jobs.</td>
</tr>
<tr>
<td></td>
<td>Private</td>
<td>This mode prevents unknown devices from discovering the printer. To print in Private mode, first search for the printer once in Public mode. After your device has discovered the printer in Public mode once, it will subsequently be able to communicate with and print from it in Private mode.</td>
</tr>
<tr>
<td></td>
<td>Bonding (Pairing)</td>
<td>This mode requires that a four-digit Passkey be entered into a device before it can communicate with and print from the printer.</td>
</tr>
</tbody>
</table>
### Menu Item Settings Description

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BT Encryption</td>
<td>On/Off (Default = Off)</td>
<td>Select On to encrypt communication. Encryption requires that a four-digit Passkey be entered into a device before it can communicate with and print from the printer.</td>
</tr>
<tr>
<td>BT Passkey Setting</td>
<td>Any four-digit number (Default = 0000)</td>
<td>The Passkey Setting allows you to set the four-digit Passkey that must be entered into a device before printing if Bonding (Pairing) is selected as the Communication Mode or if Encryption is On.</td>
</tr>
<tr>
<td>BT Device Address</td>
<td>Set at the factory (Example) 11-11-11-11-11-11</td>
<td>Displays the unique Bluetooth Device Address of the printer.</td>
</tr>
</tbody>
</table>
# Resetting Default Settings

This table lists the default settings for your printer. You may need to reset your settings to the defaults before printing.

<table>
<thead>
<tr>
<th>Option</th>
<th>Default Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Crop</td>
<td>Off</td>
</tr>
<tr>
<td>Filter</td>
<td>None</td>
</tr>
<tr>
<td>Automatic Correction</td>
<td>P.I.M.</td>
</tr>
<tr>
<td>Small Image Enhancer</td>
<td>Off</td>
</tr>
<tr>
<td>Contrast</td>
<td>Standard</td>
</tr>
<tr>
<td>Brightness</td>
<td>Standard</td>
</tr>
<tr>
<td>Saturation</td>
<td>Standard</td>
</tr>
<tr>
<td>Sharpness</td>
<td>Standard</td>
</tr>
<tr>
<td>Date</td>
<td>None</td>
</tr>
<tr>
<td>Time</td>
<td>None</td>
</tr>
<tr>
<td>Photo Information</td>
<td>None</td>
</tr>
<tr>
<td>Fit to Frame</td>
<td>On</td>
</tr>
<tr>
<td>Quality</td>
<td>High</td>
</tr>
<tr>
<td>Bidirectional Printing</td>
<td>On</td>
</tr>
<tr>
<td>Memory Card Overwrite</td>
<td>Enable</td>
</tr>
<tr>
<td>Platen Gap</td>
<td>Normal</td>
</tr>
<tr>
<td>Print Mode</td>
<td>Advanced Print Mode</td>
</tr>
<tr>
<td>Paper Type</td>
<td>Prem.Glossy (Premium Glossy Photo Paper)</td>
</tr>
<tr>
<td>Paper Size</td>
<td>4 x 6&quot;</td>
</tr>
<tr>
<td>Layout</td>
<td>Borderless</td>
</tr>
</tbody>
</table>
Printing From Your Computer

When you print from your computer, you can edit and enhance photos, create custom CDs or DVDs with your text or photos, or create greeting cards and calendars, and then print them out. Before you start, make sure your printer software is installed as described on the Start Here sheet.

Note: To print photos from your computer, you can use a program like Film Factory or EPSON Print CD, which are included on the CD-ROM that came with your printer.

If you're printing photos from your digital camera, you can automatically copy them to your computer just by inserting the camera's memory card in your printer's memory card slot. See page 48 for more information.

If your digital camera supports PRINT Image Matching (P.I.M. or P.I.M. II) or Exif Print, you can use these technologies to ensure the most accurate reproduction of your photographs. See page 78.

For all types of printing, follow the instructions in these sections:
- “Copying Photos to Your Computer” on page 48
- “Basic Printing in Windows” on page 50
- “Basic Printing on a Macintosh” on page 53
- “Customizing Your Print Settings” on page 58
- “Selecting the Correct Paper (Media) Type” on page 61
- “Printing Borderless Photos” on page 62
- “Printing On CDs or DVDs” on page 67
- “Using PRINT Image Matching” on page 78
Copying Photos to Your Computer

If you’ve taken digital photos with your camera, you can insert the memory card into your printer’s memory card slot and copy the photos to your computer. You can access the contents of the card just like any drive on your computer.

1. Make sure your computer and printer are connected by a USB cable and turned on.
2. Insert the memory card into the appropriate slot on the printer, as shown:

![CompactFlash or Microdrive](left)
![Memory Stick, SD (Secure Digital), or MMC (MultiMediaCard)](middle)
![SmartMedia or xD Picture Card](right)

   It won’t be possible to insert the card fully; this is normal.

   Avoid inserting more than one card at a time, or you may not be able to tell which card the printer is taking the images from.

3. In Windows XP, you see a screen like this:
   You can choose any supported programs or options to open, view, or print your photos.

   On a Macintosh with Mac OS® X or Mac OS 9.x, you see a drive icon appear on your desktop. You can open the drive and copy your photos to your computer. If you have iPhoto™ and you have it set to open when a digital camera is connected, it will open when you insert a memory card.

   In Windows 2000, Me, 98, or Mac OS 8.6, PhotoStarter opens and copies your pictures to the Photos folder on your desktop. If this is the first time you’ve inserted a memory card, you see this message instead. Follow the instructions on page 49 to respond to the message and configure PhotoStarter.
4. When done copying your photos, remove the card as described on page 50.

**Caution:** If you access the card from your computer and delete files from the card, add files to the card, or format the card, the card may not work correctly with your camera and the printer may not be able to read the files on the card. Always format cards and delete pictures using your camera, and do not copy files to the card from your computer.

### Configuring PhotoStarter

1. When you see the message on page 48, click **Next**. The PhotoStarter setup assistant opens:

2. Click **Next** again. The setup assistant asks you a series of questions about how you want PhotoStarter to work.

   The default settings do the following whenever you insert a memory card:

   - PhotoStarter copies your pictures to the Photos folder on your desktop.
   - The pictures are stored in folders by date.
   - Film Factory opens automatically.

   **Note:** Film Factory lets you view, modify, and print photos from your computer quickly and easily. To learn more about this program, see page 78.

3. Change any of the settings you want, then click **Next**. When you see the Confirmation window, click **End**.

   You can go back and change settings at any time by opening PhotoStarter:

   - In Windows, click **Start**, point to **Programs** (or **All Programs**), Film Factory, and click **EPSON PhotoStarter3.0**. Open the Settings menu and choose **Change Settings**.
   - On a Macintosh, open the **EPSON PhotoStarter** folder, then double-click **EPSON PhotoStarter**. Open the Tools menu and choose **Change Settings**.
Removing a Memory Card

Once you’re finished copying photos from your memory card, follow the steps below to remove it. Be sure to remove any cards before unplugging the USB cable from your printer.

**Caution:** Do not eject a card while the processing light is flashing, or without performing the steps described below, or you may lose data on the card. Be sure all cards have been removed before unplugging the USB cable.

1. Depending on your operating system, you may need to do one of the following:
   - On a Macintosh, drag the memory card icon from your desktop to the trash.
   - If you’re using Windows XP or 2000, click the [Unplug or Eject Hardware] icon on the taskbar. In Windows XP, click [Safely Remove USB Mass Storage Device]. In Windows 2000, click [Stop USB Mass Storage Device].

2. To remove a card, pull it straight out of the slot.

Basic Printing in Windows

1. From the file menu, click **Print**. You see a Print window like this one:

   ![Print window](image)

   - Select your printer name here
   - Click here to open your printer software

2. Make sure **EPSON Stylus Photo R300 Series** is selected.
3. Click the **Preferences** or **Properties** button. (If you see a **Setup**, **Printer**, or **Options** button, click it. Then click **Preferences** or **Properties** on the next screen.)

4. Select the following in the Printing Preferences or Properties window:

5. Select from these **Quality Types**:
   - **Draft**: for rough drafts with reduced print quality
   - **Text**: For text-only documents with higher text quality
   - **Text & Image**: For documents with text and images with higher quality
   - **Photo**: For photos and graphics with good quality and speed
   - **Best Photo**: For photos or graphics with high print quality

   **Note**: The Quality Type settings on this screen give you the best combination of quality and speed for most prints. For the highest quality (Photo RPM) on selected papers, click the Advanced button on the Main tab. Then see “Customizing Windows Print Settings” on page 58 for instructions on selecting Photo RPM.
6. Select the paper Type for the paper you've loaded. See “Selecting the Correct Paper (Media) Type” on page 61 for more information about paper types.

7. Select other settings as shown above.

**Tip:** For more information about printer settings, click the ? or Help button.

8. Click OK.

9. At the Print window, click OK or Print to start printing.

During printing, this window appears and shows the progress of your print job. You can use the buttons to cancel, pause, or resume printing. You can also see how much ink you have left.

### Selecting Default Settings

Your printer settings only apply to the program you're currently using. If you want, you can change the Windows default printer settings for all your programs.

1. Right click the printer icon in the lower right corner of your screen (taskbar).

2. Select Printer Settings. You see the window shown in “Basic Printing in Windows” on page 50.

3. Select the default settings you want for all your applications, then click OK.

You can still change the printer settings in your program, if necessary.
Basic Printing on a Macintosh

After you create your document, follow the basic steps in one of these sections to print it:

■ For Macintosh OS X applications, see below.
■ For Macintosh OS 8.6 to 9.x applications, see page 56.

Printing in OS X

If you’re printing from an OS X compatible application, follow the steps below to print a document. (If you’re using an application that’s compatible only with Macintosh Classic mode, follow the steps on page 56 instead.)

1. From the File menu, select Page Setup. You see this menu:

2. Open the Format for menu and select the Stylus Photo R300 printer.
   (See page 62 for details about printing borderless photos.)
3. Select the correct paper size from the Paper Size menu.
   \textbf{Caution:} When printing with borders using a custom paper size, make sure the selected size matches the paper you loaded and is within the printable area for the printer. For example, never choose a size wider than the printer’s sheet feeder or longer than the paper. (See the Reference Guide for printer specifications.)
4. If you want to change the orientation of your printout, click the appropriate button.
5. When you’re finished with the Page Setup settings, click OK.
   \textbf{Tip:} When printing envelopes, click the \textbf{icon. See page 15 to load envelopes.}
6. Select **Print** from the File menu. You see a screen like this:

7. Open the Printer menu and select **Stylus Photo R300**.
8. Select **Print Settings** from the pop-up menu.
9. Select the following Print Settings as necessary:

   - **Printer**: Stylus Photo R300
   - **Presets**: Standard
   - **Page Setup**: Standard
   - **Media Type**: Plain Paper
   - **Color**: Color
   - **Mode**: Automatic
   - **Quality**:
   - **Speed**: Select Speed (for faster printing)
   - **Print Quality**: Normal
   - **Super MicroWeave**: 
   - **High Speed**: 
   - **Mirror Image**: 

**Tip**: For more information about printer settings, click **Help**.
10. You can also choose these options in the pop-up menu:
   - **Copies & Pages**, to select the number of copies or a page range
   - **Layout**, to select page layout options
   - **Output Options**, to save your print job as a PDF file
   - **Color Management**, to select ColorSync®, adjust the color controls, change the gamma setting, or turn off color adjustments by the printer software
   - **Summary**, to view a list of all your selections

11. Click **Print**.

12. To monitor the progress of your print job, click the **Print Center** icon when it appears in the dock. Then double-click your printer name (**Stylus Photo R300**). You see a screen like this:

13. Monitor the progress of your print job or do one of the following:
   - Click the print job, then click **Delete** to delete the job
   - Click the print job, then click **Hold** to pause printing
   - Click a print job marked “Hold” and click **Resume** to resume printing
   - If multiple print jobs are listed and you want one to print before the other(s), select the job and click the **Status** arrow to move it up.

14. When you’re finished, close Print Center.
Printing with OS 8.6 to 9.x

1. From the File menu, select Page Setup. You see the following:

   ![Page Setup window](image)

   - Make sure you see SP R300 Series
   - Select your paper size
   - Select the orientation of your document

2. Make sure SP R300 Series is selected. If not, you need to select your printer in theChooser.

3. Select the correct Paper Size, Orientation, and other settings. Then click OK.

   **Note:** To print without borders, see page 62. To print double-sided pages, refer to your on-screen Reference Guide (see page 10).

4. From the File menu, select Print. You see a window like the following:

   ![Print window](image)

   - Select the type of paper you loaded
   - Select the ink color
   - Select Automatic mode
   - Select higher quality or faster printing

The most important thing to remember is to set the correct Media Type for the paper you're using.
5. You can make changes to the following settings:
   - Choose the paper you're printing on (click the arrow to scroll through the Media Type list). If you're not sure which setting to select, see page 61.
   - Set the Ink option to Color to print a color document or black-and-white photo. To print a black text document, click Black.
   - Set the Mode option to Automatic. It's the easiest way to get good printing results on all types of paper.
   - Set the slider in the Mode box to Quality or Speed to select high-quality printing or faster printing (not available for all paper types).

You can also do the following:
   - Click to reduce or enlarge your image, print multi-page layouts, or add a watermark.
   - Click to control background printing and schedule print jobs.
   - Click to change the Print button to Preview. You can then click it to preview your printout.
   - Click to check your ink levels.

Tip: For more information about printer settings, click the button.

6. Click Print to start printing. If you turned on background printing, you can open the EPSON MonitorIV window by selecting it in the Application menu in the upper-right corner of your screen.

If you're not using background printing and you need to cancel printing, hold down the key and press the . (period) key. For more information on printing—for example, printing posters or adding a watermark—see your on-screen Reference Guide (described on page 10).

Note: Keep your pictures and unused paper away from high temperatures and humidity and out of direct sunlight. See page 16 for more information about storing and displaying your pictures.
Customizing Your Print Settings

You can use custom settings for color management, printing at higher resolutions, and selecting a variety of special effects.

Customizing Windows Print Settings

You can use advanced settings for color matching, printing at a higher resolution, or selecting a variety of special effects and layouts.

1. On the Main tab, click the Advanced button in the bottom right corner of the window.

2. If you see a warning note, click Continue.

3. Select the following advanced settings as necessary:

![Diagram of Epson Print Settings](image)

**Note:** For the highest print quality, select **Photo RPM**. Please note that printing will take longer in this mode.

For more information about advanced settings, or instructions on saving them as a group so you can reuse them later, click the ? or Help button. If you want to use the Advanced screen each time you access your printer settings, select the **Show this screen first** checkbox.
Once you’ve finished selecting advanced settings, you can:

- Click OK to save your settings, return to the Print dialog box, and print.
- Click the Basic button to return to the Basic settings.
- Click the Page Layout tab and continue with step 5 to select layout options.

4. Select the following page layout settings as necessary:

5. Click OK to save your settings, then click OK or Print.
Customizing Macintosh Print Settings

1. In Macintosh OS X, click Advanced Settings.
   In Macintosh OS 8.6 or 9.x, select Custom under Mode, then click Advanced.

   ![Print Settings Interface]

   Select a higher print quality (select Photo RPM for the best print quality on photo and glossy paper types)

2. Select a higher print quality, if necessary. (Some settings may not be available, depending on your selected paper type.)

3. Adjust any Color Management settings, if necessary. (Mac OS X: Select Color Management from the Print Settings menu.)

4. Select any other advanced settings you want to use. For details, click the ? button.

5. Mac OS X: Click Print.
   Mac OS 8.6 to 9.x: Click OK to save your settings, then click Print.
Selecting the Correct Paper (Media) Type

When printing, always be sure to select the correct Media Type setting. This tells the printer what kind of paper you're using so it can adjust the ink coverage accordingly.

Here are the settings you should choose for your paper when printing from your computer:

<table>
<thead>
<tr>
<th>*For this paper . . .</th>
<th>Select this Paper (Media Type) setting . . .</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper sheets or envelopes</td>
<td>Plain Paper</td>
</tr>
<tr>
<td>EPSON Iron-On Transfer Paper</td>
<td></td>
</tr>
<tr>
<td>EPSON Premium Bright White Paper</td>
<td>Bright White Paper</td>
</tr>
<tr>
<td>EPSON Photo Quality Ink Jet Paper</td>
<td></td>
</tr>
<tr>
<td>EPSON Photo Quality Ink Jet Cards</td>
<td></td>
</tr>
<tr>
<td>EPSON Photo Quality Self Adhesive Sheets</td>
<td></td>
</tr>
<tr>
<td>EPSON Matte Paper Heavyweight</td>
<td>Matte Paper - Heavyweight</td>
</tr>
<tr>
<td>EPSON Double-Sided Matte Paper</td>
<td></td>
</tr>
<tr>
<td>PremierArt Matte Scrapbook Photo Paper for Epson</td>
<td></td>
</tr>
<tr>
<td>EPSON Photo Paper</td>
<td>Photo Paper</td>
</tr>
<tr>
<td>EPSON Glossy Photo Paper</td>
<td>Glossy Photo Paper</td>
</tr>
<tr>
<td>EPSON Photo Quality Glossy Paper</td>
<td></td>
</tr>
<tr>
<td>EPSON Glossy Photo Greeting Cards</td>
<td></td>
</tr>
<tr>
<td>EPSON Premium Glossy Photo Paper</td>
<td>Premium Glossy Photo Paper</td>
</tr>
<tr>
<td>EPSON Photo Stickers</td>
<td></td>
</tr>
<tr>
<td>EPSON Premium Luster Photo Paper</td>
<td>Premium Luster Photo Paper</td>
</tr>
<tr>
<td>EPSON Premium Semigloss Photo Paper</td>
<td>Premium Semigloss Photo Paper</td>
</tr>
<tr>
<td>EPSON Semigloss Scrapbook Photo Paper</td>
<td></td>
</tr>
<tr>
<td>EPSON ColorLife Photo Paper</td>
<td>ColorLife Photo Paper</td>
</tr>
<tr>
<td>EPSON Ink Jet Transparencies</td>
<td>Ink Jet Transparencies</td>
</tr>
</tbody>
</table>

*The availability of paper types varies by location.
Printing Borderless Photos

You can print your photos without margins, extending the image all the way to the edges of the page. Although borderless printing is a bit slower, you get beautiful snapshots or enlargements without trimming.

<table>
<thead>
<tr>
<th>Paper name</th>
<th>Sizes</th>
<th>Paper type or Media Type setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>EPSON Matte Paper Heavyweight</td>
<td>Letter (8.5 × 11 inches) 8 × 10</td>
<td>Matte Paper - Heavyweight</td>
</tr>
<tr>
<td>EPSON Glossy Photo Paper</td>
<td>Letter (8.5 × 11 inches) 4 × 6</td>
<td>Glossy Photo Paper</td>
</tr>
<tr>
<td>EPSON Premium Glossy Photo Paper</td>
<td>Letter (8.5 × 11 inches) 4 × 6, 5 × 7, 8 × 10</td>
<td>Premium Glossy Photo Paper</td>
</tr>
<tr>
<td>EPSON Premium Semigloss Photo Paper</td>
<td>Letter (8.5 × 11 inches)</td>
<td>Premium Semigloss Photo Paper</td>
</tr>
<tr>
<td>EPSON Premium Luster Photo Paper</td>
<td>Letter (8.5 × 11 inches)</td>
<td>Premium Luster Photo Paper</td>
</tr>
</tbody>
</table>

**Caution:** If you use an unsupported paper size, ink may get inside your printer and mar future printouts.
Load your paper, then follow the steps below for your operating system.

- Always load the short edge first, even for printing landscape-oriented photos.
- Load the printable side face up. It's usually whiter or brighter than the other side.
- Load premium papers up to 20 sheets at a time.
- Check the paper package for additional loading instructions.

**Windows**

Follow these steps to print borderless photos:

1. Start your photo program and open your photo.
2. Open the File menu and click **Print**. Then click **Properties** or **Preferences**.
You see the following screen:

3. Select Photo or Best Photo as the Quality Type setting.
4. Choose Sheet as the paper Source setting.
5. Select one of the following paper types:
   - Matte Paper Heavyweight
   - Photo Paper
   - Glossy Photo Paper
   - Premium Glossy Photo Paper
   - Premium Luster Photo Paper
   - Premium Semigloss Photo Paper
6. Click the Borderless checkbox. Read the message and click OK.
7. Select your paper Size setting.
8. Select Portrait or Landscape as the orientation setting.
   Click OK, then click OK or Print.
Macintosh OS X

1. Select Page Setup from the File menu. You see this window:

   ![Page Setup Window]

   - Select Stylus Photo R300(Sheet Feeder - Borderless)
   - Choose the correct paper size

2. Open the Format for menu and select Stylus Photo R300(Sheet Feeder - Borderless):

3. Choose the correct Paper Size.

   **Caution:** When printing with borders using a custom paper size, make sure the selected size matches the paper you loaded and is within the printable area for the printer. For example, never choose a size wider than the printer’s sheet feeder or longer than the paper. (See the Reference Guide for printer specifications.)

4. Click OK.

5. Select Print from the File menu.

6. Open the Printer pull-down menu and select Stylus Photo R300(Sheet Feeder - Borderless)—the same borderless option you chose in the Format for menu on the Page Setup window.

7. Click Print.
**Macintosh OS 8.6 to 9.x**

1. Select **Page Setup** from the File menu. You see this window:

2. Select the correct **Paper Source** and **Paper Size**, and check the **Borderless** box.

3. Click **OK**.

4. Select **Print** from the File menu and then click **Print**.
Printing On CDs or DVDs

Your printer includes a special tray that lets you print customized text, graphics, and photos directly on any ink-jet printable CD or DVD. The EPSON Print CD software makes it easy to import your own photos, add text, and modify your designs with a variety of special effects. You can print on both standard-size 12-cm CDs and 8-cm mini CDs.

**Caution:** Use only ink jet-printable CDs or DVDs for printing. Thermal-printable and regular CDs and DVDs should not be used with this printer.


Follow the steps in these sections:
- “Cleaning the Roller” below
- “Designing CDs and DVDs” on page 68
- “Inserting a CD or DVD” on page 70
- “Printing Your Design” on page 72
- “Adjusting the Print Position” on page 75
- “Adjusting the Print Density” on page 77

**Cleaning the Roller**

Before you print on CDs or DVDs, it’s a good idea to clean the roller inside the printer. You can do this by feeding and ejecting several sheets of plain paper.

1. Make sure the printer is turned on and letter-size paper is loaded.
2. Press the \( \text{More Options} \) button on your printer to choose More Options and press OK.
3. Press the \( \text{Paper Feed/Paper Eject} \) button to highlight Paper Feed/Paper Eject and press OK.
4. Press OK to feed paper into the printer.
5. Make sure Paper Feed/Paper Eject is still highlighted, then press OK. Press OK again to eject the paper from the printer.
6. Repeat steps 4 and 5 several times.
Designing CDs and DVDs

You can use EPSON Print CD to create and print a design with images, graphics, and text.

1. To add a background image, click the or Background icon. You see a window like the following:

   ![Select Background Window]

   - **Windows**: Click the File tab, then click Browse to locate the folder where your images are stored and click OK. You see thumbnail images of all the files in the folder. Select your image and click OK.
   - **Macintosh**: Click Select Background, locate the folder where your images are stored, select the one you want, and then click Open.

   **Note**: In Windows, if you have already chosen a background, you see a different screen. Click Select Image to choose a new background.

2. Do one of the following:
   - **Windows**: Click the File tab, then click Browse to locate the folder where your images are stored and click OK. You see thumbnail images of all the files in the folder. Select your image and click OK.
   - **Macintosh**: Click Select Background, locate the folder where your images are stored, select the one you want, and then click Open.

Note: In Windows, if you have already chosen a background, you see a different screen. Click Select Image to choose a new background.
3. If you want to modify the template or enhance your image, do one of the following:
   ■ **Windows**: Click the © background icon, then click Image Adjustment.
   ■ **Macintosh**: Use any of the available editing features. You can adjust the brightness, contrast, and gamma, or apply mosaic, blur, or special color effects.

![Image Adjustment](image1.png)

Windows

![Image Adjustment](image2.png)

Macintosh

4. To add text, do one of the following:
   ■ **Windows**: Click the ABC text button to add a text block on the CD image. Enter your text and use the tabs to apply formatting and special effects, then click OK. (To open the window again, double-click any block of text.)
   ■ **Macintosh**: Click the T text button to add a block of text. Select the block of text, then use any of the options on the Text Settings palette. You can also modify the text with any of the options on the Color Settings and Object Settings palettes.

![Text Settings](image3.png)

Windows

![Text Settings](image4.png)

Macintosh
5. To curve a single line of text, click the text, then drag the red “handle” up or down.

6. When you’re finished, choose **Save as** from the File menu to save your file.

   **Note:** To check your design, it’s a good idea to print it on a sheet of plain paper before printing on a CD or DVD. Make sure you have plain paper loaded in the printer, then follow the instructions in “Printing Your Design” on page 72 to print.

When you’re ready to load a CD or DVD, follow the instructions in “Inserting a CD or DVD” below.

---

**Inserting a CD or DVD**

Make sure the data, music, or video is burned on your ink-jet printable CDs or DVDs before you print. Otherwise, dirt or scratches on the surface may cause errors when you burn the data. If you plan to print large numbers of CDs or DVDs, it’s a good idea to print a small sample, then wait a day and check the quality to make sure it is satisfactory.

If you want to check the print position or color, see the instructions for “Adjusting the Print Position” on page 75 and “Adjusting the Print Density” on page 77.

Before you insert a CD or DVD, make sure the printer is turned on. Otherwise, the disc may not be positioned correctly.

Then follow these steps to load CDs and DVDs into your printer:

   **Caution:** If you don’t insert the tray correctly, you may damage the printer or tray.

1. Lift the printer lid and push in the output tray extension.
2. Lower the CD/DVD tray guide.

3. Place the CD or DVD on the CD tray with the white or printable side face-up. Make sure the disc lays flat on the tray.

To print on a small CD (8 cm), place the small CD ring on the tray first, then place the CD inside the ring.

**Caution:** Make sure you always use the small CD ring when printing 8 cm CDs and that the CD and ring lay flat on the tray; otherwise the printer may be damaged.
4. Insert the tray carefully, making sure it is level, not tilted up or down. Push the tray under the tab and the two rollers. Don't push the tray in too far; line up the arrows exactly.

5. Follow the instructions in “Printing Your Design” below to print with EPSON Print CD.

**Printing Your Design**

After you have created your design and loaded a CD or DVD, you're ready to print.

1. Open the File menu and select **Printer Settings** (Windows) or **Page Setup** (Macintosh).

2. Do one of the following:
   - **Windows**: Make sure **Stylus Photo R300** is selected, the Paper Source is set to **Manual**, and the Paper Size is set to **A4**.
Macintosh OS X: Make sure Stylus Photo R300 is selected and the Paper Size is set to A4.

Macintosh OS 9: Make sure Stylus Photo R300 is selected, the Paper Source is set to Manual Feed, and the Paper Size is set to A4.

3. Click OK.
4. Open the File menu and select Print. Then do one of the following:
   - Windows: When you see the screen below, click OK.
- **Macintosh OS X:** When you see the screen below, choose Print Settings from the pop-up menu.

![Choose Print Settings](image)

Choose CD/DVD for the Media Type setting, then click Print.

![Choose CD/DVD](image)

- **Macintosh OS 9:** When you see the screen below, click Print.

![Print Screen](image)

5. Click OK (Windows) or Print (Macintosh).

**Note:** After you print, handle the CD or DVD carefully. To allow the ink to dry fully, wait at least 24 hours before playing the disc or inserting it in a drive. Keep printed discs away from moisture and direct sunlight.
If you want to check the print position or color, see the instructions for “Adjusting the Print Position” below and “Adjusting the Print Density” on page 77.

**Adjusting the Print Position**

If your printed images and text are not centered or positioned the way you want, you may need to adjust the printing position. Use the blank cardboard position check disk included with your printer, or an extra CD. You can also use these steps to check the position before you print on a CD or DVD:

1. Place the position check disk (or an extra CD) on the CD tray and insert it into the printer, as described on page 70.
2. Start EPSON Print CD.
3. Follow the instructions in “Printing Your Design” on page 72 to make sure your EPSON Stylus Photo R300 Series printer is selected, and the Paper Source is set to Manual or Manual Feed.
4. Select Print from the File menu.
5. In Windows or Mac OS 9, select Print Position Confirmation (or Check) Pattern. In Mac OS X, choose EPSON Print CD from the pop-up menu, then choose Print Position Check Pattern.
6. Click **OK** (Windows) or **Print** (Macintosh). The confirmation pattern is printed on the position check disk or CD.

7. Remove the position check disk or CD and measure the distance from the edge of the hole to the small cross marks (distances labeled A and B as shown). You'll need a metric ruler with millimeters for these measurements.

8. Open the File menu and select **Adjust Print Position**. You see a screen like this:

9. Make sure **Enter Values** or **Value Entry** is checked, then input the A distance in the **Height (Top)** or **Top Space** box. Enter the B distance in the **Width (Right)** or **Right Space** box.

10. Click **OK** to save the measurements to the EPSON Print CD program.
**Adjusting the Print Density**

If ink smears on your printed CDs or DVDs, you may need to adjust the color saturation or ink density. CDs from different manufacturers may absorb ink differently, so you may need to adjust the density for each type of disc. Follow these instructions to print a color saturation check pattern, and then make adjustments as necessary.

1. Insert a test CD or DVD for printing, as described on page 70.
2. Start EPSON Print CD.
3. Follow the instructions in “Printing Your Design” on page 72 to make sure your EPSON Stylus Photo R300 Series printer is selected, the Paper Size is set to **A4**, and the Paper Source is set to **Manual** (Windows) or **Manual Feed** (Mac OS 9).
4. Select **Print** from the File menu.
5. In Windows or Mac OS 9, select **Print Density Confirmation** (or **Check Pattern**). In Mac OS X, select **EPSON Print CD** from the pop-up menu then choose **Print Density Confirmation**.
6. Click **OK** (Windows) or **Print** (Macintosh).
7. After the pattern is printed, examine the print and make the **Print Color Correction** (or **Color Correction**) setting lighter or darker as necessary.
   You can print three density patterns on one disc. Each pattern is printed in a different location.
   After the first pattern is printed, adjust the setting, then repeat steps 4 through 6, selecting **Second** or **Second Time** to print the second pattern.
   If you want to try a third Color Correction setting, you can repeat steps 4 through 6 again and select **Third** or **Third Time**.
8. Remove the CD or DVD and let it dry for at least 24 hours. Then check the saturation levels again.
   You can also use the Brightness and Contrast settings in EPSON Print CD to adjust color saturation. See “Designing CDs and DVDs” on page 68 for instructions.
Using PRINT Image Matching

With PRINT Image Matching (P.I.M. or P.I.M. II), special print instructions are saved in your digital photo files. For example, macro mode pictures might include print commands for sharpness and clarity, while portrait mode pictures might emphasize soft focusing and subtle flesh tones. If your digital camera supports PRINT Image Matching, you can use this technology when you print with one of the following:

■ Film Factory, as described below
■ P.I.M. II Plug-in for Adobe Photoshop, as described on page 82

Using Film Factory

If your digital camera supports PRINT Image Matching or Exif Print, you can use these technologies when you print with Film Factory to ensure the most accurate image reproduction. Printing with P.I.M. isn't complicated, and it provides the color corrections right from your P.I.M. image file, so you don't have to correct them yourself. Just leave the PRINT Image Matching box checked.

You can also use Film Factory to organize, retouch, and print non-P.I.M. and non-Exif Print digital images.

Opening Your Photos in Film Factory

1. Start Film Factory. You see the main Film Factory screen.
2. Click View, then choose Roll. You see a screen like the one below:

![View, then choose Roll](image.png)

**Note:** If you need help with Film Factory, select it from the Help menu or check the on-screen Getting Started Guide that was installed with Film Factory.

3. Select a “roll of film” or click the Roll button and select New Roll.

4. If your photos were taken with a digital camera that supports PRINT Image Matching, the P.I.M. logo appears in your photo thumbnails. Right-click (Windows) or Ctrl-click (Macintosh) a photo thumbnail to display information about the P.I.M., P.I.M. II, or Exif Print data in the photo file. (If you retouched a PRINT Image Matching photo, the P.I.M. logo may not appear.)

5. Click the photo you want to print, or click the All button at the top of the screen to select all the photos in a roll. Then go to step 6.

6. To import a photo into Film Factory, click the Import button, then:
   - Click From File to import a photo from your computer’s hard drive.
   - Click From Removable Media to import a photo from a disk or CD-ROM.
   - Click From PC Card to import a photo from a PC card in a card reader.
   - Click From Twain Device to import a photo from a scanner or digital camera. If your device is already selected, the software will open. If not, click Import Settings, and select your scanner or digital camera.
7. Click a button on the left to select a print option. For example, click the **Standard Prints** button. You see buttons for each step you need to follow, as shown.

**Note:** You can rotate, trim, and correct for red eyes and still retain Print Image Matching or Exif Print image quality with your photo. However, if you adjust other settings, such as brightness and color, your P.I.M. or Exif Print data and image quality will be lost.

To ensure you keep P.I.M. or Exif Print data and image quality in your original photo file, make a copy of the photo before you edit. Then make edits only to your copy.

When you're ready to print, continue with the steps in the next section.

**Printing Your Photos**

1. When you're ready to print, click the **Print Assignment** button. You see this screen:
2. **Windows and Macintosh OS 8.6 to 9.x**: Select these options in the Printer Settings box at the bottom of the screen, in this order:

1. Make sure your printer is selected.
2. Select **Sheet Feeder** or **Sheet Feeder (No Margins)** for borderless printing.
3. Select your paper size.
4. Select the Media Type.

**Macintosh OS X**: Select these options in the Printer Settings box at the bottom of the screen, in this order:

1. Make sure your printer is selected.
2. Select **Standard** or **Sheet Feeder - Borderless** for borderless printing.
3. Select your paper size.
4. Select the Media Type.

3. If you want to print the current date with your photo, click the **Print Date** box.
4. Click the **Print** button on the left side of the screen. You see more options:

- Select the number of copies you want to print.
- Leave these boxes checked for the best printed output using P.I.M. and/or Exif Print data, if available.
5. If your photo doesn't look right in the preview, click the Back button to change your settings. (Click the Detailed Preview button for a closer look.)

6. Select the number of copies you want to print.

7. Leave the PRINT Image Matching and/or Exif Print box checked for the best results when printing photos containing P.I.M. and/or Exif Print data.

8. Click the Print button at the top of the screen.
   - Windows: Your pictures are printed.
   - Macintosh OS X: You see the Print window; click Print. Your pictures are printed.
   - Macintosh OS 8.6 to 9.x: You see the Print window; click Print. Your pictures are printed.

Store your prints in resealable plastic bags, photo albums, or glass-covered picture frames. Keep your pictures and unused paper away from high temperatures, humidity, and direct sunlight. Make sure you return unused paper to its original package.

**Using the P.I.M. II Plug-in for Adobe Photoshop**

The P.I.M. II Plug-in for Adobe Photoshop allows you to retain the PRINT Image Matching or Exif Print image quality when you import JPEG or TIFF files from your P.I.M.-, P.I.M. II-, or Exif Print-enabled digital camera. The P.I.M. II Plug-in works with Photoshop 7.0, 6.0, and Photoshop Elements 1.0 and 2.0. You'll also need to use the ICC profiles for your printer that are installed with the plug-in (Windows) or the printer driver (Macintosh).

Photoshop doesn't retain the PRINT Image Matching or Exif Print information separately in the header file when you import your P.I.M., P.I.M II, or Exif Print image. Instead, it converts that information in the file and embeds a color space called EPSON RGB 2001. This profile supports all the P.I.M. color advantages and enhancements.

You can crop, rotate, resize, work with layers, play with filters, and even make selective color adjustments to the P.I.M. image while retaining P.I.M. quality. However, you won't benefit from global color adjustments (such as Auto Levels, Auto Contrast, Auto Color, etc.). Also, if you try to use your new Photoshop file in another P.I.M.-enabled software program, it won't be recognized as a P.I.M. image. You need to keep your original file if you want to take advantage of P.I.M. information in other programs.

**Note:** The examples in the sections below show Macintosh screens. Windows screens look slightly different, but the settings are the same.
**Importing a P.I.M. Image**

1. If you’re using Photoshop Elements, change your color settings before importing a P.I.M. image. Select **Color Settings** from the Edit menu, then select **Full color management - optimized for Print** and click OK.

2. Open the File menu and select **Import > PRINT Image Matching II**. You see a window like this:

3. Select the folder containing your P.I.M. or Exif Print images. (In Windows, all your files are listed; on a Macintosh, only P.I.M. and Exif Print files appear.)

4. Select the image you want to import.

5. To see a preview of the P.I.M., Exif Print, or color extension effects for the selected image, check the **Image Preview** box. (In Windows, non-P.I.M. and non-Exif Print images cannot be previewed.)

6. Choose an import option:
   - **PRINT Image Matching II** enables the greatest range of image enhancements and effects. It also supports the EPSON RGB expanded color space, which is similar to the Adobe RGB color space and is required for PRINT Image Matching image quality prints. This setting is available only for P.I.M. and P.I.M. II images.
   - **Exif Print** enables Exif 2.2 effects and allows for an expanded color space. This option does not use P.I.M. II settings and is available only for files that contain Exif Print data.
   - **Color extension only** enables you to print using an expanded color space, but does not include P.I.M. II or Exif print effects, such as brightness, sharpness, and other settings. This option is available only for P.I.M. II and Exif Print images.

7. Click the **Open** button. Your image opens and the window remains on the screen.

**Note:** If you see this screen, select **Use the embedded profile** and click **OK**.
8. Select and open more images, or click Cancel to close the Open PRINT Image Matching II file window. (If you don’t want the window to remain on the screen after you open a file, uncheck Import consecutively.)

9. Follow the steps in the next section to print your P.I.M. image.

To keep the P.I.M. header information intact for use in other P.I.M.-enabled programs, keep the original file; don’t use the Photoshop Save command. Instead use Save As to rename the file. It won’t contain P.I.M. header information, but will retain P.I.M. image quality, as long as the file is saved with the ICC profile embedded.

Note: If you overwrite your original file, you will lose all P.I.M. header information.

**Printing a P.I.M. Image**

P.I.M. images are converted into the EPSON RGB 2001 color space. To retain P.I.M. quality and enhancements, don’t change the color space.

1. Open the File menu, then:
   - Photoshop 7.0 or Elements: Select Print Preview > Print Options, or Print with Preview. Then click Show More Options > Color Management.
   - Photoshop 6.0: Select Print.

   You see a window like this:

2. In the Print Space box, select the Stylus Photo R300 profile for the paper you’re printing on. We recommend Perceptual as the Intent setting.

3. Photoshop 7.0 or Elements: Click Print. You see the printer settings window.
   - Photoshop 6.0: In Windows, click Setup, then select your printer and click Properties or Preferences. Go to step 5.

---

84 Printing From Your Computer
4. Select the paper you're printing on as the Media Type.
5. **Windows**: Click Custom, then click Advanced. You see the Advanced options.
   - **Macintosh OS X**: Choose Print Settings from the pop-up menu, then click Advanced.
   - **Macintosh 8.6 to 9.x**: Under Mode, click Custom, then click the Advanced button. You see the Advanced screen.
6. Select Photo, Best Photo, or Photo RPM as the Print Quality.
7. **Windows**: Select No Color Adjustment and click OK.
   - **Macintosh OS X**: Select Color Management from the pop-up menu. Select No Color Adjustment.
   - **Macintosh 8.6 to 9.x**: Select No Color Adjustment and click OK.
8. Continue clicking OK (Windows) or click Print (Macintosh) to print your photo.
Maintaining Your Printer

This chapter describes maintenance procedures to keep your printer working its best, and preparation steps for moving your printer. Follow the instructions here for:

- “Cleaning the Print Head” on page 88
- “Replacing an Ink Cartridge” on page 89
- “Aligning the Print Head” on page 93
- “Cleaning the Printer” on page 94
- “Transporting the Printer” on page 95

**Note:** You can also maintain your printer from the Maintenance tab on your driver (Windows) or from the EPSON Printer Utility (Macintosh). For details, read your on-screen Reference Guide (described on page 10).

The steps in this chapter must be performed with the printer set to Advanced mode. Press the mode button to choose **Advanced.**
Cleaning the Print Head

If your printouts are unexpectedly light or faint, or dots or lines are missing from the image, you may need to clean the print head. This unclogs the nozzles so they can deliver ink properly. Print head cleaning uses ink, so clean it only if quality declines.

You can clean the print head either from the printer’s control panel or using your printer software. To clean using the printer software, the printer must be connected directly to your computer (not over a network); see your on-screen Reference Guide for details.

**Caution:** When you don’t turn on your printer for a long time, the print quality can decline, so turn it on at least once a month to maintain good print quality.

Follow these steps to clean the print head from the printer’s control panel:

1. Make sure the printer is turned on but not printing, and the red error light is off.
   
   If the red light is flashing or on, you may need to replace the ink cartridge; see page 89 for details.

2. Press the button to highlight More Options, then press OK.

3. Use the or button to highlight Head Cleaning, then press OK.

4. To begin cleaning, press OK.

   While cleaning, the printer makes noise and you see a progress bar on the control panel display. Cleaning takes about 30 seconds.

   **Caution:** Do not turn off the printer or interrupt the cleaning process.

5. When the cleaning is done, run a nozzle check to confirm the print head nozzles are clean.

   Make sure letter-size plain paper is loaded in the printer, then press Stop. The nozzle check pattern prints (see the next section for details).

6. If the pattern has gaps or missing dots, press Stop to clean the print head again.

   If the nozzle check pattern looks correct, press OK to finish.
If you don't see any improvement after cleaning three or four times, check the solutions beginning on page 102. You can also turn the printer off and wait overnight—this allows any dried ink to soften—and then try cleaning the print head again.

**Examining the Nozzle Check Pattern**

Examine the nozzle check pattern you printed. Each staggered horizontal and straight vertical line should be complete, with no gaps in the dot pattern, as shown below:

- If your printout looks okay, you’re done.
- If any dots are missing (as shown below), clean the print head again; see page 88 for instructions.

**Replacing an Ink Cartridge**

You can check the status of the ink cartridges by looking at the icons on the control panel. Press the button to scroll down to More Options.

The level of ink shown on the icons indicates the approximate amount of ink remaining. If an ink cartridge is low, the red error light flashes. This is a good time to make sure you have a new cartridge. If an ink cartridge is empty, the red error light remains on and you see a message on the display telling you that the cartridge needs to be replaced.

**Caution:** You cannot print if any ink cartridge is empty. Leave the empty cartridge installed in the printer until you have obtained a replacement, or the ink remaining in the print head nozzles may dry out. To ensure good results, use genuine EPSON ink cartridges and do not refill them. Other products may cause damage to your printer not covered by EPSON’s warranty.
When an installed cartridge is more than six months old, you may need to replace it if printouts don't look their best. If the quality doesn't improve after cleaning and aligning the print head, you can replace the cartridge even if the error light is off.

Use these EPSON ink cartridges within six months of installing them and before the expiration date on the package:

<table>
<thead>
<tr>
<th>Cartridge</th>
<th>Part Number</th>
<th>Capacity*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black</td>
<td>T048120</td>
<td>450 pages at 5% coverage, 630 pages at 3.5% coverage</td>
</tr>
<tr>
<td>Magenta</td>
<td>T048320</td>
<td>430 pages at 5% coverage</td>
</tr>
<tr>
<td>Cyan</td>
<td>T048220</td>
<td>430 pages at 5% coverage</td>
</tr>
<tr>
<td>Yellow</td>
<td>T048420</td>
<td>430 pages at 5% coverage</td>
</tr>
<tr>
<td>Light Magenta</td>
<td>T048620</td>
<td>430 pages at 5% coverage</td>
</tr>
<tr>
<td>Light Cyan</td>
<td>T048520</td>
<td>430 pages at 5% coverage</td>
</tr>
</tbody>
</table>

* The figure given is based on continuous printing after ink replacement. Cartridge yields will vary with images printed, print settings, paper types, and frequency of use.

When you need new ink cartridges, contact your dealer, call the EPSON Store at (800) 873-7766, or visit www.epsonstore.com (U.S. sales only). In Canada, please call (800) 463-7766 for dealer referral.

**Removing and Installing Ink Cartridges**

Be sure you have a new ink cartridge before you begin. Once you start the ink cartridge replacement procedure, you must complete all the steps in one session.

1. Make sure the printer is turned on and not printing, then open the printer cover.
2. Do one of the following:
   - If the red error light is on (cartridge is empty), press the maintenance button.
   - If the red error light is flashing (cartridge is low), press the maintenance button. You see Ink Cartridge Replacement highlighted in the Advanced Settings menu. Press OK.
   - If the error light is off, press the button to choose More Options, then press OK. Press the button to select Ink Cartridge Replacement.
3. You see a message on the display telling you that ink cartridge replacement will begin. Press OK to continue. The print head moves to the replacement position.
4. Open the cartridge cover.

5. Press in the tab on the back of the cartridge and lift the cartridge out of the printer. Dispose of it carefully.

**Warning:** Keep ink cartridges out of the reach of children and do not drink the ink.

If ink gets on your hands, wash them thoroughly with soap and water. If ink gets in your eyes, flush them thoroughly with water.

6. Unwrap the new ink cartridge.

**Caution:** Don’t touch the green circuit boards or remove any labels.
7. Lower the cartridge into the holder, with the green circuit board facing the front. Then gently push the cartridge down until it is firmly seated.

8. If you need to replace another ink cartridge, repeat steps 5 through 7 before continuing with step 9.

9. Close the cartridge cover.

10. Press the left front corner of the cartridge cover forward to lock the cover into place.

11. Press OK and close the printer cover.

   The printer begins charging the ink delivery system.

12. When you see a message that charging is complete (after about a minute), press OK to finish.
Aligning the Print Head

If your printouts contain misaligned vertical lines or horizontal banding, you may need to align the print head.

You can align the print head either from the printer's control panel or using your printer software. To align the print head from the printer software, the printer must be connected directly to your computer (not over a network); see your on-screen Reference Guide for details.

**Note:** For the best results, load letter-size EPSON Photo Quality Ink Jet Paper in the printer whenever you check the print head alignment.

Follow these steps to align the print head using the control panel:

1. Make sure the printer is turned on but not printing, and letter-size paper is loaded.
2. Press the button to highlight More Options, then press OK.

3. Press the or button until Print Head Alignment is highlighted, then press OK.
4. Press OK to print the alignment pattern.
5. Once the pattern is done printing, examine the first row or set of lines (marked #1). Select the line (1-15) in which all the vertical dots are best aligned. You may need to use a magnifying glass.
6. Use the and buttons to display the number of that line (1-15), then press OK.
7. Repeat the selection of the best line for set #2, set #3, and set #4.
8. When you're finished, press OK.
Cleaning the Printer

To keep your printer working at its best, you should clean it several times a year. Follow these steps:

1. Turn off the printer, unplug the power cord, and disconnect the printer cable.
2. Remove all paper, then use a soft brush to clean any dust or dirt from the sheet feeder.
3. Clean the exterior of the printer with a soft, damp cloth.
4. Use a soft, dry cloth to clean the display and preview monitor. Do not use liquid or chemical cleaners on these parts.
5. If ink has spilled inside the printer, wipe it off with a soft, damp cloth.

   **Caution:** Be careful not to wipe away lubricating grease inside the printer.

   Don’t touch the gears inside the printer.

   Never use a hard or abrasive brush, or alcohol or thinner for cleaning; they can damage the printer components and case.

   Don’t get water on the printer components and don’t spray lubricants or oils inside the printer.

   Don’t use any cleaning sheets included with special paper; they may jam inside the printer.
Transporting the Printer

If you move your printer some distance, you need to prepare it for transportation in its original box or one of a similar size.

**Caution:** To avoid damage, always leave the ink cartridges installed when transporting the printer.

1. Turn on the printer, wait until the print head locks in the far right position, then turn off the printer.
2. Unplug the power cord from the electrical outlet. Then disconnect the printer cable from the printer.
3. Remove any memory cards from the printer and close the memory card cover.
4. Remove any paper from the printer, push down the paper support extension, and close the paper support.
5. Open the printer cover. Secure the ink cartridge holder to the printer with tape as shown, then close the printer cover.

![Tape the ink cartridge holder to the printer](image)

6. Make sure the CD/DVD tray guide is closed, then push in the output tray extension and close the output tray.
7. If your printer has a preview monitor, disconnect the cable from the printer and lift the monitor off of the printer.
8. Repack the printer and its attachments in the original box using the protective materials that came with them. See your *Start Here* sheet.

Keep the printer level as you transport it. After transporting the printer, remove the tape securing the print head and test your printer. If you notice a decline in print quality, clean the print head (see page 88); if output is misaligned, align the print head (see page 93).
Problem Solving

See these sections to diagnose and solve printer problems:
- “Diagnosing Problems” below
- “Setup or Software Installation Problems” on page 101
- “Printer Problems” on page 102
- “Print Quality Problems” on page 103
- “Problems With Paper Feeding” on page 106
- “CD/DVD Printing Problems” on page 107
- “Miscellaneous Printout Problems” on page 107
- “Uninstalling Printer Software” on page 109
- “Where To Get Help” on page 111

Diagnosing Problems

Your EPSON Stylus Photo R300 Series printer includes a number of ways to help you diagnose problems:
- To identify the most common problems, check for messages on the control panel display and follow the instructions provided.
- If you’re not sure whether the problem is coming from your printer or the computer, run a printer check as described on page 100.
- Check for solutions in the following sections of this chapter. If none of the suggested solutions solve your problem, contact EPSON as described on page 111.
## Control Panel Messages

<table>
<thead>
<tr>
<th>Display</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ink out.</td>
<td>Replace the ink cartridges shown with new ones.</td>
</tr>
<tr>
<td>Black: T0481&lt;br&gt;Cyan: T0482&lt;br&gt;Magenta: T0483&lt;br&gt;Yellow: T0484&lt;br&gt;Light Cyan: T0485&lt;br&gt;Light Magenta: T0486</td>
<td>The genuine EPSON ink cartridges listed above are recommended for replacement.</td>
</tr>
<tr>
<td>A paper jam has occurred. See printer manual to clear the jam.</td>
<td>Press the maintenance button to eject the jammed paper.</td>
</tr>
<tr>
<td>Ink cartridges cannot be recognized.</td>
<td>Reinstall the cartridge shown.</td>
</tr>
<tr>
<td>Black: T0481&lt;br&gt;Cyan: T0482&lt;br&gt;Magenta: T0483&lt;br&gt;Yellow: T0484&lt;br&gt;Light Cyan: T0485&lt;br&gt;Light Magenta: T0486</td>
<td>The genuine EPSON ink cartridges listed above are recommended for replacement.</td>
</tr>
<tr>
<td>Service required. Parts inside your printer are at the end of their service life. See your printer’s documentation for details.</td>
<td>Contact your dealer.</td>
</tr>
<tr>
<td>Multi-page feed error&lt;br&gt;Multiple pages have been fed into the printer at once, or the wrong paper size has been fed into the printer. Remove and reload the paper, then press the maintenance button.</td>
<td>Remove and reload the paper, then press the maintenance button.</td>
</tr>
<tr>
<td>Display</td>
<td>Solution</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Close the CD/DVD guide.</td>
<td>Close the CD/DVD guide, then press the maintenance button. If the CD/DVD tray is inserted, remove the CD/DVD tray, then close the CD/DVD guide.</td>
</tr>
<tr>
<td>The CD/DVD tray is not set correctly. Reload the tray, then press the maintenance button.</td>
<td>Reload the CD/DVD tray, then press the maintenance button.</td>
</tr>
<tr>
<td>The inserted card cannot be used with this printer.</td>
<td>Use a compatible and formatted memory card. (See page 19.)</td>
</tr>
<tr>
<td>Bluetooth Photo Print Adapter error. Disconnect the Adapter from the printer, then reconnect it.</td>
<td>Disconnect the adapter, then reconnect to the printer.</td>
</tr>
<tr>
<td>System error. Simultaneously press and hold the Power and Stop button for 7 seconds to turn off the printer.</td>
<td>Turn the printer off, and, after a few seconds, turn it on again. If the error is not cleared, contact your dealer.</td>
</tr>
<tr>
<td>Ink icon blinks</td>
<td>The printer is low on ink. Obtain a replacement ink cartridge.</td>
</tr>
<tr>
<td>Communicating with computer. Please wait.</td>
<td>Start printing from the LCD panel after printing from the computer is completed.</td>
</tr>
<tr>
<td>The connected device cannot be used.</td>
<td>Connect an external storage device that is compatible with the printer. (See page 20.)</td>
</tr>
</tbody>
</table>
Running a Printer Check

You may need to run a printer check to see if a problem comes from the printer itself or some other source.

1. Make sure both the printer and computer are turned off. Then disconnect the USB cable from the printer.
2. Make sure letter-size or larger paper is loaded in the printer.
3. Turn on the printer.
4. Press the Maintenance button.
5. Press the button to highlight More Options, then press OK.

![Menu Diagram]

6. Use the or button to highlight Nozzle Check, then press OK.
7. Press OK to print the nozzle check.
8. The printer prints a page showing a nozzle check pattern. (If the pattern has gaps, you need to clean the print head; see page 88.)
   - If the check page printed, the problem probably lies in your memory card, software settings, interface cable, or computer, or your software may not be installed correctly.
   - If the check page did not print, you may have a problem with your printer. Try the suggestions in “Setup or Software Installation Problems” beginning on page 101. If nothing works, contact your dealer or EPSON as described on page 111.
9. After examining the check page, remember to turn off the printer and reconnect its cable to your computer.
Setup or Software Installation Problems

The printer makes noise after ink cartridge installation.

- The first time you install ink cartridges, the printer must charge its print head for about two minutes. Wait until charging finishes before you turn off the printer, or it may charge improperly and use excess ink the next time you turn it on.

- Make sure the ink cartridge cover is closed completely and no packing material remains in the printer. Turn off the printer, wait a moment, then turn it back on to clear the error.

You’re having problems installing the printer software.

- Carefully follow the installation instructions on the *Start Here* sheet. Do not connect your printer to the computer until you are instructed to connect it. When you connect, make sure the USB cable is connected securely to the printer and the computer. Also make sure your system meets the requirements shown on page 113.

- Close your other programs, including any screen savers and virus protection software, and install again.

- If your printer icon (SP R300 Series) doesn’t appear in the Macintosh Chooser, you may have too many items in the Chooser. Delete any unused items and check the Chooser again.

- If you are using Macintosh OS X and you do not see the printer name or borderless printer option in the Format for menu under Page Setup, you may need to set up your printer in the Print Center utility. See the *Start Here* sheet for instructions.

- For Windows 2000, if you see an error message or your software doesn’t install correctly, you may not have software installation privileges. Contact your System Administrator.

- Make sure Windows 98, Me, 2000, or XP was preinstalled on your system. The USB Printer Device Driver may not install correctly if you’ve upgraded from Windows 95.

- Make sure the USB Controller is working properly in Device Manager. See your Windows help system for details. If it’s not working, contact your computer manufacturer.

- If you’re printing over a network, see your on-screen *Reference Guide* for instructions on configuring your printer for use on a network.
Printer Problems

The printer is on, but nothing prints.
- If you're printing from your computer, make sure the USB cable is connected securely and that the cable meets the system requirements on page 113.
- If you're printing from your computer, run a printer check as described on page 100. If the check page prints, make sure your software is installed correctly.
- If you're printing on a network, you need to set up your printer for network printing, as described in your on-screen Reference Guide.

The printer sounds as though it is printing, but nothing prints.
- Make sure the print head nozzles are not clogged. To clean the print head, see page 88.
- The printer won’t operate properly if it’s tilted or at an angle. Place it on a flat, stable surface that extends beyond the printer base in all directions.

Your printer makes noise when you turn it on or after it has been sitting for awhile.
Your printer is performing routine maintenance.

The preview monitor and control panel respond too slowly.
When you have lots of photos or large files on your memory card, it takes longer for the preview monitor to process them. This causes the monitor and control panel to respond more slowly. Try deleting any photos you don’t need before you remove the card from your camera.

Printing is too slow.
Make sure your system meets the requirements listed on page 113. If you’re printing a high-resolution image, you need more than the minimum requirements listed. You may also need to:
- Clear space on your hard drive or run a defragmentation utility.
- Close open programs that you’re not using.
- Increase your system’s memory (RAM).
For the fastest printing, try these tips:
- Choose Black ink if your document doesn’t include color.
- Set the Quality/Speed slider to Speed.
- In the Advanced options, turn MicroWeave® off and/or turn High Speed on.
- If your printer is connected to a hub, disconnect USB devices that you're not using.

  **Note:** Borderless printing takes longer than normal, especially near the edges of the paper. Printing without a computer is also a bit slower.

- If you are printing a landscape photo without a computer, it takes longer for the printer to rotate and process the image.
- Check the printer's control panel settings to see if Small Image Enhancement is on. If it is on, turn it off. See page 29.

**Your memory card does not work correctly.**

- If you're using different kinds of memory cards, make sure only one card is inserted at a time.
- Make sure the card contains no more than 999 photos (or the last photos won't display), and that the photos are in JPEG or Uncompressed Tiff format and taken with a DCF-compliant digital camera.
- Make sure you follow the instructions on the *Start Here* sheet to install the software, including the card utilities: Card Monitor and PhotoStarter.
- Check your PhotoStarter settings. See page 49 for instructions.
- If you access the card from your computer and delete files, the card may not work correctly with your camera. Always delete pictures using your camera.
- If you're using Windows XP, you may need to install your Windows storage device driver.

---

**Print Quality Problems**

**You see banding (light lines).**

- The print head nozzles may need cleaning; see page 88 for instructions.
- Select a higher print quality and turn off High Speed mode. See page 58 (Windows) or page 60 (Macintosh).
- If you're printing without a computer, make sure the printer's Paper Type setting matches the type of paper you're using; see page 27 for guidelines.
If you're printing from a computer, make sure the paper Type/Media Type setting matches the paper you loaded; see page 61 for guidelines.

Make sure the printable side of the paper is face up. It's usually whiter or shinier.

The ink cartridges may need replacing. To replace an ink cartridge, see page 89.

Run the Print Head Alignment utility; see page 93 for instructions.

Your printout is blurry or smeared.

Use EPSON papers to ensure proper saturation and absorption of genuine EPSON inks.

Make sure you load paper with the printable side face up. The printable side is usually the whiter or brighter side of the paper.

Make sure your paper isn't damp or curled, or loaded face down (the printable side should be face up). If it's damp or curled, reload a new stack of paper.

When printing on special paper, check the instructions in the paper package. You may need to use an included support sheet or load your paper one sheet at a time.

Make sure your paper meets the specifications listed in the on-screen Reference Guide.

Run the Print Head Alignment utility. See page 93 for instructions.

Remove each sheet from the output tray after printing, especially when you're printing on transparencies.

If the options above don't work, try using the Thick paper and envelopes setting:

Windows: From the Maintenance tab in the Printing Properties or Preferences window, click Printer and Option Information, then select Thick paper and envelopes.

Mac OS X: From the Print window, choose Extension Setting in the popup menu, then select Thick paper and envelopes.

Mac OS 9: From the Advanced print window, select Thick paper and envelopes.

Make sure you disable the Thick paper and envelopes option before printing on other types of paper, or print quality may be reduced.

Your printout is grainy.

Try using a higher quality paper.

Select a higher print quality setting. If you're printing from Windows, see page 58. If you're printing from a Macintosh, see page 60.
■ Run the Print Head Alignment utility. See page 93 for instructions.
■ You may need to increase the image resolution or print it in a smaller size; see your software documentation.

Your printout is faint or has gaps in the image.
■ The print head nozzles may need cleaning; see page 88 for instructions.
■ The ink cartridges may be old or low on ink. To replace an ink cartridge, see page 89.
■ If you're printing without a computer, make sure the printer's Paper Type setting matches the type of paper you're using; see page 27 for guidelines.
■ If you're printing from a computer, make sure the paper Type/Media Type setting matches the paper you loaded; see page 61 for guidelines.
■ Make sure your paper isn't damaged, old, dirty, or loaded face down. If it is, reload a new stack of paper with the printable side up; it is usually whiter or shinier than the other side.

You see wrong or missing colors.
■ Make sure the Ink setting is set to Color for color images or black-and-white prints and your software is set for color printing.
■ The print head nozzles may need cleaning; see page 88 for instructions.
■ The ink cartridges may be old or low on ink. To replace an ink cartridge, see page 89.
■ Try turning off PhotoEnhance. Also check if you're using a special effect that alters image colors, like Sepia.
■ Try changing the Gamma setting in the Advanced window; see page 58 for information about accessing Advanced settings.
■ Your printed colors can never exactly match your on-screen colors. However, you can use a color management system to get as close as possible. You can also use your printer's color management features. See page 58 (Windows) or page 60 (Macintosh).
■ Colors will change slightly after drying. Wait for 24 hours and check your print again to see if the colors look right.
■ If you are printing without a computer, check your printer's control panel settings to make sure the Filter setting is not set to Sepia or B&W and that the image adjustment settings are set to Standard. See page 30.
Problems With Paper Feeding

Paper doesn’t eject fully or is wrinkled.
- If the paper doesn’t eject fully, you may have set the wrong paper size. Press the maintenance button to eject the paper, and then select the correct paper size.
- If it’s wrinkled when it ejects, the paper may be damp or too thin.

Paper doesn’t feed correctly or jams in the printer.
- Make sure the paper support extension is pulled up.
- If paper doesn’t feed, remove it from the sheet feeder, reload it against the right edge, then slide the left edge guide against the paper.
- If multiple pages feed at once, remove the paper from the sheet feeder, fan the edges to separate the sheets, and carefully reload it.
- If paper jams, press the maintenance button to clear the jam. If that doesn’t resolve the paper jam, open the cover and remove any jammed paper, including small pieces that may have torn off. Reload the paper and press the maintenance button.

If your paper loads incorrectly or jams frequently:
- Use new, smooth, high-quality paper, loaded printable side up. Don’t load paper above the arrow mark on the left edge guide.
- Place the paper against the right edge and slide the left edge guide against it, but not too tight.
- Store paper flat to prevent curling.
CD/DVD Printing Problems

Images and text are not centered on the CD/DVD.
Adjust the print position as described on page 75.

Ink smears on the CD/DVD or printing is too light.
- Adjust the print density as described on page 77.
- Adjust the brightness or contrast as described on page 68.
- Make sure you’re using ink-jet printable CDs or DVDs.
- Handle the disc carefully and allow the ink to dry for at least 24 hours before playing the disc or inserting it in a drive.

Printed CDs or DVDs are dirty.
Clean the roller. See page 36 (stand-alone printing) or page 67 (printing from a computer).

The CD or DVD won’t feed into the printer.
Make sure you hold the CD/DVD tray level as you load it into the tray guide without tilting it up or down. Don’t push in the tray too far, but line up the arrows exactly as described on page 37 (stand-alone printing) or page 70 (printing from a computer).

Miscellaneous Printout Problems

The image is inverted.
Turn off the Flip Horizontal setting in the Advanced window or the mirror setting in your program. (If you’re printing on EPSON Iron-On Transfer Paper, the image should be inverted.)

The printer prints blank pages.
- Make sure your printer is selected, or is the active printer in the Print Center or Macintosh Chooser.
- The print head nozzles may need cleaning. See page 88.
The margins are incorrect.
- Make sure the paper settings are correct for your paper size.
- Make sure the paper is positioned correctly in the feeder, all the way to the right. Slide the left edge guide against the paper.
- See your software documentation for instructions on choosing the correct margins for your paper size. The margins must be within the printable area of the page. See “Printer Specifications” in your on-screen Reference Guide.
- If you are printing without a computer, make sure the Crop and Fit to Frame settings are set to Off. See page 31.

Image size or position is incorrect.
- Make sure paper and layout options are set correctly.
- Your images may not match the width/height proportions (aspect ratio) of the paper size or layout you’re using. Images may be cropped to fit the paper and layout.

You see incorrect characters.
- Make sure the USB cable is securely connected and meets the system requirements on page 113. Then try printing again.
- Make sure your printer is selected in your software, or is set as the active printer in the Print Center or Macintosh Chooser.
- If you’re using a USB hub, connect the printer directly to your computer instead.

The wrong photo is printed.
The photo numbering in the printer may not match the numbering in your camera. If you’re printing without a computer, first print an index to identify your photos by number.

Too many copies are printing.
Make sure that the Copies option in your printer software or program is not set for multiple copies.
Uninstalling Printer Software

You may need to uninstall and then reinstall your printer driver and utilities. For example, this might be necessary when you upgrade your operating system. You don't need to uninstall Film Factory, the P.I.M. II Plug-in, or your on-screen Reference Guide.

Note: Do not turn off or disconnect the printer while you are uninstalling the software.

Windows

1. Double-click My Computer (Windows XP: click Start > My Computer), then double-click the Control Panel icon.
2. Double-click Add/Remove Programs.
3. Click EPSON Printer Software in the program list and click the Add/Remove button (Change/Remove button on Windows 2000 and XP).
4. In the next window, make sure your EPSON Stylus Photo R300 Series printer icon is selected and click OK. Then follow the on-screen instructions.
5. In Windows 98 or Me, click EPSON USB Printer Devices in the program list and click the Add/Remove button.
   If you are using Windows XP or 2000, go to step 9.
6. When you see the prompt asking if you want to reboot, click No.
7. Click EPSON PhotoStarter3.0 in the program list and click the Add/Remove button. Then follow the on-screen instructions.
8. Click EPSON CardMonitor in the program list and click the Add/Remove button. Then follow the on-screen instructions.
9. Restart your computer when you're done.

When you are ready to reinstall the printer software, follow the correct instructions for your operating system on your printer's Start Here sheet.

Note: Remember that you don’t need to reinstall your optional photo software or on-screen Reference Guide, and you won’t see the license agreement.
Macintosh OS X

Follow these steps to uninstall EPSON PhotoStarter and Card Monitor, and your printer driver:

1. Open your Applications folder.
2. Drag the EPSON Card Monitor and EPSON PhotoStarter3 for X folders to the trash.
3. Open the Utilities folder (in the Applications folder).
4. Double-click the Print Center icon.
5. Select EPSON Stylus Photo R300 and then click Delete.
6. Select EPSON Stylus Photo R300(Sheet Feeder - Borderless) and then click Delete.
7. Close Print Center.

When you are ready to reinstall the printer software, follow the correct instructions for your operating system on your printer’s Start Here sheet.

Note: Remember that you don’t need to reinstall your optional photo software or on-screen Reference Guide, and you won’t see the license agreement.

Macintosh OS 8.6 to 9x

1. Close all applications.
2. Insert the printer software CD-ROM.
3. In the EPSON window, scroll down and double-click the Drivers folder.
4. Double-click the OS 8-9 folder.
5. Double-click the SPR300 icon and click Continue.
6. In the Installer dialog box, select Uninstall from the pull-down menu and click the Uninstall button. Follow the on-screen instructions and click Quit when you’re done.
7. In the Drivers folder, double-click the OS 8-9 folder, then double-click the Storage Driver icon.
8. Select Uninstall from the pull-down menu and click the Uninstall button. Follow the on-screen instructions and click Quit when you’re done.
9. In the Drivers folder, double-click the CardMonitor folder, double-click the OS 8-9 folder, then double-click the Installer icon. When you see the license agreement, click Accept.
10. Select Uninstall from the pull-down menu and click the Uninstall button. Follow the on-screen instructions and click Quit when you're done.

11. In the Drivers folder, double-click the PhotoStarter folder, double-click the OS 8-9 folder, then double-click the Installer icon. When you see the license agreement, click Accept.

12. Select Uninstall from the pull-down menu and click the Uninstall button. Follow the on-screen instructions and click Quit when you're done.

13. Restart your Macintosh.

When you are ready to reinstall the printer software, follow the correct instructions for your operating system on your printer's Start Here sheet.

**Note:** Remember that you don’t need to reinstall your optional photo software or on-screen Reference Guide, and you won’t see the license agreement.

---

### Where To Get Help

EPSON provides technical assistance 24 hours a day through the electronic support services and automated telephone services listed below:

<table>
<thead>
<tr>
<th>Service</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>World Wide Web</td>
<td>From the Internet, you can reach EPSON Support at <a href="http://support.epson.com">http://support.epson.com</a>. At this site, you can download drivers and other files, look at product documentation, access troubleshooting information, and receive technical advice through e-mail.</td>
</tr>
<tr>
<td>Automated Telephone Services</td>
<td>A variety of automated help services are available 24 hours a day, seven days a week. To use these services, you must have a touch tone telephone and call (800) 922-8911. Your EPSON SoundAdviceSM code is 70500. Use this code to quickly select the EPSON Stylus Photo R300 Series printer in SoundAdvice.</td>
</tr>
</tbody>
</table>

To speak to a technical support representative, dial:

- U.S.: (562) 276-7282, 6 AM to 8 PM, Pacific Time, Monday through Friday and 7 AM to 4 PM, Saturday.
- Canada: (905) 709-2567, 6 AM to 6 PM, Pacific Time, Monday through Friday.

Toll or long distance charges may apply.
Before you call, please have the following information ready:

- Product name (EPSON Stylus Photo R300 or EPSON Stylus Photo R300M)
- Product serial number (located on the back of the printer)
- Proof of purchase (such as a store receipt) and date of purchase
- Computer configuration
- Description of the problem

You can purchase ink cartridges, paper, manuals, and accessories from the EPSON Store at (800) 873-7766 or visit www.epsonstore.com (U.S. sales only). In Canada, please call (800) 463-7766 for dealer referral.
Notices

Windows System Requirements

- A Microsoft Windows compatible PC with a Pentium® or better processor, 233 MHz or faster processor
- Windows 98 SE, Windows Me, Windows 2000, or Windows XP
- 64MB of RAM (128MB or more recommended, 256MB or more recommended for Windows XP)
- 200MB or more available hard disk space recommended
- VGA or better display adapter and monitor
- CD-ROM or DVD drive for installing the printer software
- Windows-compliant USB port and a shielded USB “AB” cable up to 6.5 feet (2 meters) long.

  Caution: Using an improperly shielded USB cable—especially a cable more than 6.5 feet (2 meters) long—may cause the printer to malfunction.

Macintosh System Requirements

- An Apple® iMac™ series, Power Macintosh® G3, G4, or G5, PowerBook®, iBook™, or eMac™
- Mac® OS 8.6 through 9.x, or OS X 10.2.x
- 64MB of available RAM (128MB for OS X); more recommended
- 200MB or more available hard disk space recommended
- VGA display or better
- CD-ROM or DVD drive for installing the printer software
- Built-in USB port and a shielded USB “AB” cable up to 6.5 feet (2 meters) long.

  Caution: Using an improperly shielded USB cable—especially a cable more than 6.5 feet (2 meters) long—may cause the printer to malfunction.
Important Safety Instructions

Before using your printer, read the following safety instructions to make sure you use the printer safely and effectively:

- Be sure to follow all warnings and instructions marked on the printer.
- Use only the type of power source indicated on the printer's label.
- Connect all equipment to properly grounded power outlets. Avoid using outlets on the same circuit as photocopiers or air control systems that regularly switch on and off.
- Place the printer near a wall outlet where the plug can be easily unplugged. 
  *Placez l'imprimante près d'une prise de contacte où la fiche peut être débranchée facilement.*
- Do not let the power cord become damaged or frayed.
- If you use an extension cord with the printer, make sure the total ampere rating of the devices plugged into the extension cord does not exceed the cord's ampere rating. Also, make sure the total ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet's ampere rating.
- Keep your printer and computer system away from potential sources of electromagnetic interference, such as loudspeakers or cordless telephone base units.
- Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.
- Leave enough room around the printer for sufficient ventilation.
- Do not place the printer near a radiator or heating vent or in direct sunlight.
- Place the printer on a flat, stable surface that extends beyond the printer base in all directions. The printer will not operate properly if it is tilted or at an angle.
- Turn off and unplug the printer before cleaning. Clean with a damp cloth only. Do not spill liquid on the printer.
- Use a soft, dry cloth only to clean the display and preview monitor. Do not use liquid or chemical cleaners on these parts.
- Always leave the cover on the preview monitor slot, unless you are using the preview monitor.
- Always turn the printer off using the power button. It may take a moment for the printer to shut off after you press the button. Don't switch off the power strip or unplug the printer until the printer is off.
- Do not block or cover the openings in the printer's case or insert objects through the slots.
- Except as specifically explained in this manual, do not attempt to service the printer yourself.
- Do not remove a memory card or turn off the printer while the computer and card are communicating (when the light next to the card is flashing). Doing so can corrupt files on the memory card.
If the liquid crystal solution from the display or the preview monitor gets on your hands, wash them thoroughly with soap and water. If the liquid crystal solution gets into your eyes, flush them immediately with water. If discomfort or vision problems remain after a thorough flushing, see a physician immediately.

Unplug the printer and refer servicing to qualified service personnel under the following conditions:

If the power cord or plug is damaged; if liquid has entered the printer; if the printer has been dropped or the case damaged; if the display or preview monitor are damaged; if the printer does not operate normally or exhibits a distinct change in performance. Adjust only those controls that are covered by the operating instructions.

**Ink Cartridge Safety Instructions**

Keep ink cartridges out of the reach of children and do not drink the ink.

Be careful when you handle used ink cartridges; there may be ink remaining around the ink supply port. If ink gets on your skin, wash it off with soap and water. If it gets in your eyes, flush them immediately with water.

Do not put your hand inside the printer or touch the cartridge during printing.

Do not move the print head by hand. You may damage the printer.

Install the ink cartridge immediately after you remove it from its package. Leaving the cartridge unpacked for a long time before use can result in reduced print quality.

Do not use an ink cartridge beyond the date printed on the package. For best results, use up the ink cartridges within six months of first installing them.

Store ink cartridges in a cool, dark place.

After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room temperature for at least three hours before using it.

Do not shake an ink cartridge; this can cause leakage.

Do not dismantle the ink cartridges or try to refill them. This could damage the print head.

Do not touch the green IC chip on the side of the cartridge. This may affect normal operation and printing.

If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and store it in the same environment as the printer. Note that there is a valve in the ink supply port, making covers or plugs unnecessary, but care is needed to prevent the ink from staining items that the cartridge touches. Do not touch the ink cartridge ink supply port or surrounding area.

Before transporting the printer, make sure the print head is capped in the far right position and the ink cartridges are in place. Tape the ink cartridge holder to the printer case to make sure it remains in the proper position.
ENERGY STAR Compliance

As an ENERGY STAR Partner, EPSON has determined that this product meets the ENERGY STAR guidelines for energy efficiency. The EPA ENERGY STAR office equipment program is a voluntary partnership with the computer and office equipment industry to promote the introduction of energy-efficient personal computers, monitors, printers, fax machines, and copiers in an effort to reduce air pollution caused by power generation.

FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio or television reception. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause interference to radio and television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

■ Reorient or relocate the receiving antenna.
■ Increase the separation between the equipment and receiver.
■ Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
■ Consult the dealer or an experienced radio/TV technician for help.

WARNING: The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC Certification of this device and may cause interference levels which exceed the limits established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded equipment interface cable with this device. If this equipment has more than one interface connector, do not leave cables connected to unused interfaces. Changes or modifications not expressly approved by the manufacturer could void the user’s authority to operate the equipment.

For Canadian Users

This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.
Declaration of Conformity

According to 47CFR, Part 2 and 15 for Class B Personal Computers and Peripherals; and/or CPU Boards and Power Supplies used with Class B Personal Computers:

We: EPSON AMERICA, INC.
Located at: MS: 3-13
3840 Kilroy Airport Way
Long Beach, CA 90806-2469
Telephone: (562) 290-5254

Declare under sole responsibility that the product identified herein, complies with 47CFR Part 2 and 15 of the FCC rules as a Class B digital device. Each product marketed is identical to the representative unit tested and found to be compliant with the standards. Records maintained continue to reflect the equipment being produced can be expected to be within the variation accepted, due to quantity production and testing on a statistical basis as required by 47CFR §2.909. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Trade Name: EPSON
Type of Product: Ink Jet Printer
Model: B281A
Epson America, Inc., Limited Warranty

What Is Covered: Epson America, Inc. ("Epson") warrants to the original retail purchaser that the EPSON printer covered by this limited warranty statement, if purchased new and used in the United States or Canada, conforms to the manufacturer's specifications and will be free from defects in workmanship and materials for a period of one (1) year from the date of original purchase. Epson also warrants that the consumable ink cartridges enclosed with the printer will perform to the manufacturer’s specified usage, which usage may expire before the expiration of the limited warranty for the EPSON printer. For warranty service, you must provide proof of the date of original purchase.

What Epson Will Do To Correct Problems: Should your EPSON printer prove defective during the warranty period, please call the EPSON ConnectionSM at (562) 276-7282 (U.S.) or (905) 709-2567 (Canada) for warranty repair instructions and return authorization. An Epson service technician will provide telephone diagnostic service to determine whether the printer requires service. If service is needed, Epson will, at its option, exchange or repair the printer without charge for parts or labor. If Epson authorizes an exchange for the defective unit, Epson will ship a replacement printer to you, freight prepaid, so long as you use an address in Canada or the U.S. (excluding Puerto Rico and U.S. Possessions). Shipments to other locations will be made freight collect. You are responsible for securely packaging the defective unit and returning it to Epson within five (5) working days of receipt of the replacement. Epson requires a debit or a credit card number to secure the cost of the replacement printer in the event that you fail to return the defective one. If your printer is being repaired, Epson will direct you to send your printer to Epson or its authorized service center, where the printer will be fixed and sent back to you. You are responsible for packing the printer and for all costs to and from the Epson authorized service center. When warranty service involves the exchange of the printer or a part, the item replaced becomes Epson property. The replacement printer or part may be new or refurbished to the Epson standard of quality, and, at Epson’s option, may be another model of like kind and quality. Epson's liability for replacement of the covered printer will not exceed the original retail selling price of the covered printer. Exchange products and parts assume the remaining warranty period of your original product covered by this limited warranty.

What This Warranty Does Not Cover: This warranty does not apply to refurbished or reconditioned products. This warranty covers only normal use in the United States and Canada. This warranty is not transferable. This warranty does not cover any color change or fading of prints or reimbursement of materials or services required for reprinting. This warranty does not cover damage to the EPSON product caused by parts or supplies not manufactured, distributed or certified by Epson. This warranty does not cover ribbons, ink cartridges or third party parts, components, or peripheral devices added to the EPSON product after its shipment from Epson, e.g., dealer or user-added boards or components. Epson is not responsible for warranty service should the Epson label or logo or the rating label or serial number be removed or should the product fail to be properly maintained or fail to function properly as a result of misuse, abuse, improper installation, neglect, improper shipping, damage caused by disasters such as fire, flood, and lightning, improper electrical current, software problems, interaction with non-Epson products, or service other than by an Epson Authorized Servicer. If a claimed defect cannot be identified or reproduced, you will be held responsible for the costs incurred.
THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN LIEU OF ALL OTHER EXPRESS OR IMPLIED WARRANTIES INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT OR FITNESS FOR A PARTICULAR PURPOSE. SOME LAWS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES. IF THESE LAWS APPLY, THEN ALL EXPRESS AND IMPLIED WARRANTIES ARE LIMITED TO THE WARRANTY PERIOD IDENTIFIED ABOVE. UNLESS STATED HEREIN, ANY STATEMENT OR REPRESENTATIONS MADE BY ANY OTHER PERSON OR FIRM ARE VOID. EXCEPT AS PROVIDED IN THIS WRITTEN WARRANTY, NEITHER EPSON AMERICA, INC. NOR ITS AFFILIATES SHALL BE LIABLE FOR ANY LOSS, INCONVENIENCE, OR DAMAGE, INCLUDING DIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES, RESULTING FROM THE USE OR INABILITY TO USE THE EPSON PRODUCT, WHETHER RESULTING FROM BREACH OF WARRANTY OR ANY OTHER LEGAL THEORY.

In Canada, warranties include both warranties and conditions.

Some jurisdictions do not allow limitations on how long an implied warranty lasts, and some jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so the above limitations and exclusions may not apply to you. This warranty gives you specific legal rights and you may have other rights which vary from jurisdiction to jurisdiction.

Epson America, Inc. ■ P.O. Box 93012 ■ Long Beach, CA 90809-3012
Index

A
Accessories, 41, 112
Adobe Photoshop, P.I.M. II plug-in for, 9, 82 to 85
Advanced Mode, 22
Advanced settings
  Macintosh, 60
  Windows, 58 to 59
Aligning print head, 93
Automatic mode, Macintosh, 54, 56

B
Background printing, 57
Banding, 103 to 104
Basic Mode, 22
Basic printing
  Macintosh, 53 to 57
  Windows, 50 to 52
Blank pages, 107
Bluetooth
  communication modes, 44
  connecting adapter, 41
  disconnecting adapter, 42
  Photo Print adapter option, 41 to 45
  printing, 43
  profiles, 41
  range, 41
  settings, 44 to 45
Blurry images, 104
BorderFree printing, 62 to 66, 81

C
Cable, printer, 113
Camera, connecting, 20
Cancelling printing
  from control panel, 27
  Macintosh, 55
  Windows, 52
CD case inserts, 39
CD-R/RW drive, 20, 20 to 21
CDs
  adjusting print density, 77
  adjusting print position, 75 to 76
  backing up files on, 39 to 40
  designing, 68 to 70
  inserting in printer, 37 to 38, 70 to 72
  ordering, 33, 67
  printing on, 37 to 38, 67 to 77
  saving memory card files on, 39 to 40
Characters, incorrect, 108
Checking printer, 100
Cleaning
  print head, 88 to 89
  printer, 94
  roller, 36, 67
  sheets, 94
Color management settings
Macintosh, 60
Windows, 58
Color problems, 105
ColorSync, 55
CompactFlash memory card, 19, 48
Controlling printing
Macintosh, 55, 57
Windows, 52
Copying photos to computer, 48 to 50
Crop marks, 32
Cropping, 31 to 32
Custom settings
  Macintosh, 60
  printing without a computer, 28
  Windows, 58 to 59

D
Default printer settings, 46
Digital camera files, 19 to 21
Digital camera, connecting, 20
DPOF (Digital Print Order Format), 18, 22, 25
DVDs, see CDs

E
Edge-to-edge printing, 62 to 66
Electronic manual, 10 to 11
Envelopes, loading, 15
EPSON
  accessories, 112
  help, 111 to 112
  ink, 90
  papers, 13 to 16, 61, 62 to 66
  Print CD, 68 to 70, 72 to 77
  Store, 13, 90, 112
EPSON PhotoCenter, 9
Exif Print
  description, 8
  with Film Factory, 78 to 82
External storage device, connecting, 20

F
Faint images, 105
Files, printing without a computer, 19 to 21
Film Factory, 9, 78 to 82
Flip Horizontal setting, 107
Full bleed printing, 62 to 66

G
Gamma setting, 58
Glossy Photo Paper, 62, 64
Grainy prints, 104
Greeting cards, 34

H
Head Cleaning utility, 88 to 89
Help, EPSON, 111 to 112
High Speed setting, 103

I
ICM (Image Color Management) setting, 58
Incorrect characters, 108
Incorrect colors, 105
Index, printing without a computer, 23
Ink cartridge
  level of ink in, 52, 57, 89
  ordering, 90
  replacing, 90 to 92
  safety instructions, 91, 115
Ink Jet Transparencies, 61
Ink level, checking
  Macintosh, 57
  Windows, 52
  without computer, 89
Installation problems, 101
Inverted image, 107
Iron-On Transfer Paper, 35

J
Jams, paper, 106
Jewel case inserts, 39
JPEG files, printing requirements, 19

L
Layout problems, 108
Layout settings
  Macintosh, 55, 57
  Windows, 59
Luster Photo Paper, 62, 64

M
Macintosh
  advanced printing, 60
  basic printing, 53 to 55
  system requirements, 113
  uninstalling software, 110 to 111
  Maintaining printer, 87 to 94
Marginless printing, 62 to 66
Margins, incorrect, 108
Media Type setting
  list of settings, 61
  Mac OS 8.6 to 9.x, 56
  Mac OS X, 54
Memory cards
  inserting, 19 to 20, 48
  removing, 20, 50
  saving files, 39 to 40
Memory Stick, 19, 48
Microdrive, 19, 48
MicroWeave setting, 103
Mirror images, 107
MMC, 19, 48
Monitoring ink level
  Macintosh, 57
  Windows, 52
  without computer, 89
Moving printer, 95
MultiMediaCard, 19, 48

N
Network printing, 101
Noise, printer, 102
Nozzle Check, 88 to 89

O
Orientation setting
  Macintosh, 53, 56
  Windows, 51, 64

P
P.I.M., see PRINT Image Matching
Page Setup
  Macintosh OS 8.6 to 9.x, 56
  Macintosh OS X, 53
Paper
  EPSON, 13 to 16, 61, 62 to 66
  feeding problems, 106
  loading, 14
  orientation, 53, 56
  size, 53, 56
Paper Size setting, Windows, 51, 64
Paper Source setting
  CDs and DVDs, 72, 73
  Windows, 64
Paper Type setting, 23, 26, 27, 52
PhotoCenter, EPSON, 9
Photographs, displaying and storing, 16
PhotoStarter, 49
PictBridge, 18
Preview monitor, 7, 31 to 32, 102
Previewing printout, 57
Print CD software, 68 to 70, 72 to 77
Print dialog box, 56
Print head
  aligning, 93
  cleaning, 88 to 89
Print Head Alignment utility, 93
PRINT Image Matching
  description, 8
  plug-in for Photoshop, 9, 82 to 85
  printing without computer, 18, 29 to 30
  with Film Factory, 78 to 82
Print position check paper, 75 to 76
Print Quality
  settings, 51
Print quality problems, 103 to 105
Print window, 50
Printer
  Advanced Mode, 22
  Basic Mode, 22
  cable, 113
  check, 100
  cleaning, 94
  default control panel settings, 46
  maintaining, 87 to 94
  noise, 102
  problems, 97 to 108
  transporting, 95
Printing
  advanced, 58 to 60
  basic, 50 to 55
  Bluetooth, 43
  BorderFree, 81
  CDs and DVDs, 37 to 38, 67 to 77
  controlling, 52, 55
  with custom settings, 58 to 60
Printing without a computer
accessing files, 19 to 21
CDs and DVDs, 37 to 38
cropping, 31 to 32
custom settings, 28
greeting cards, 34
iron-on transfers, 35
PRINT Image Matching, 18, 29 to 30
saving files, 39 to 40
selecting photos, 22 to 25
selecting settings, 26 to 30
Printing, slow, 102
Problems
installing software, 101
memory card, 103
miscellaneous, 107 to 108
paper feeding, 106
PhotoStarter, 103
preview monitor, 102
print quality, 103 to 105
printer, 97 to 108

Q
Quality Type setting, 51
Quality/Speed setting, 57

R
Reference Guide, 10 to 11
Resetting default printer settings, 46
Resolution Performance Management (RPM), 7, 60

S
Safety instructions, 114 to 115
Saving files from memory cards, 39 to 40
SD card, 19, 48
Secure Digital card, 19, 48
Self adhesive sheets, 61
Slow printing, 102
SmartMedia card, 19, 48
Smeared printout, 107

Software
Print CD, 68 to 70, 72 to 77
problems, solving, 101
summary, 9
uninstalling, 109 to 111
Stopping printing, 27
Storing photos, 16
System requirements, 113

T
Transferring photos to computer, 48 to 50
Transparencies, 61
Transporting printer, 95
Troubleshooting, 97 to 112
Type setting, 52

U
Uninstalling software, 109 to 111
USB, 20 to 21, 109, 113
Utilities
Head Cleaning, 88 to 89
Nozzle Check, 89
Print Head Alignment, 93

W
Watermark, 57, 59
Windows
basic printing, 50 to 52
system requirements, 113
uninstalling software, 109
Wireless printing, see Bluetooth

X
xD Picture Card, 19, 48

Z
Zip drive
connecting, 20 to 21
saving memory card files on, 39 to 40